DISCLAIMER OF WARRANTIES AND LIMITATION OF LIABILITY

The information, recommendations, descriptions and safety notations in this document are based on Eaton Corporation’s (“Eaton”) experience and judgment and may not cover all contingencies. If further information is required, an Eaton sales office should be consulted. Sale of the product shown in this literature is subject to the terms and conditions outlined in appropriate Eaton selling policies or other contractual agreement between Eaton and the purchaser.

THERE ARE NO UNDERSTANDINGS, AGREEMENTS, WARRANTIES, EXPRESSED OR IMPLIED, INCLUDING WARRANTIES OF FITNESS FOR A PARTICULAR PURPOSE OR MERCHANTABILITY, OTHER THAN THOSE SPECIFICALLY SET OUT IN ANY EXISTING CONTRACT BETWEEN THE PARTIES. ANY SUCH CONTRACT STATES THE ENTIRE OBLIGATION OF EATON. THE CONTENTS OF THIS DOCUMENT SHALL NOT BECOME PART OF OR MODIFY ANY CONTRACT BETWEEN THE PARTIES.

In no event will Eaton be responsible to the purchaser or user in contract, in tort (including negligence), strict liability or otherwise for any special, indirect, incidental or consequential damage or loss whatsoever, including but not limited to damage or loss of use of equipment, plant or power system, cost of capital, loss of power, additional expenses in the use of existing power facilities, or claims against the purchaser or user by its customers resulting from the use of the information, recommendations and descriptions contained herein. The information contained in this manual is subject to change without notice.

Version details

<table>
<thead>
<tr>
<th>Version</th>
<th>Date</th>
<th>Remark</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.0 EN</td>
<td>2.22.2019</td>
<td>First official version (original)</td>
</tr>
</tbody>
</table>

Legal notices

All brands and trademarks named in this document and possibly protected by third-party rights are subject without limitation to the terms of the valid trademark law and intellectual property rights of their respective registered owner.

You can find a list of the free-source and open-source software as well as copyright notes, license texts and if applicable source code on our website under the link: www.Eaton.com/TFX

Observe all local and regional laws and provisions as well as the safety instructions contained in this document.

© 2019 Eaton Corporation. All rights reserved.

Contact details

Eaton Hydraulics
14900 Technology Dr, Eden Prairie, MN 55344, USA
Phone: 1+ (952) 937-9800
Eaton.com/TFX
About this manual

This document is part of the product and provides important information on the intended use, safety, installation, and operation of the devices described below. The document is intended for qualified technicians and electricians with advanced knowledge in electrical engineering and fieldbus systems, allowing them to estimate the risks and hazards of operating the device and to integrate it into systems with components of other manufacturers.

Safety levels

The safety levels have the following meanings:

---

⚠️ **DANGER**
Severe injury or death. Probability: very high

⚠️ **WARNING**
Severe injury or death. Probability: possible

⚠️ **CAUTION**
Slight or medium injury. Probability: possible

⚠️ **NOTICE**
Property damage.

Symbols and formatting

The following symbols and formatting help you recognize the purpose of the paragraphs:

---

⚠️ **DANGER**
Nature and source of the danger
Consequences of non-observance
• Measures to avoid the danger

⚠️ **WARNING**
Nature and source of the danger
Consequences of non-observance
• Measures to avoid the danger

⚠️ **CAUTION**
Nature and source of the danger
Consequences of non-observance
• Measures to avoid the danger

---

**NOTICE**
Nature and source of the danger
Consequences of non-observance
• Measures to avoid the danger

---

**INFORMATION**
Indicates notices and information.

---

💡 **TIP**
Indicates supplementary information.

🔍 Application options for the devices described.
🔍 Indicates references to other documents, websites, etc.
🔍 Description of different model variants. Data and descriptions that only apply to certain models are either covered in separate chapters or marked with the symbol shown here.

Tasks

Tasks are structured as follows:

Task goal
Prerequisites for the described task.

1. Step 1
2. Step 2
✓ Result of correct performance of the task.
3. Step 3

Lists

Lists are indicated with an arrow.

> List item

Depictions

The following depictions are used in this document:

<table>
<thead>
<tr>
<th>Designation</th>
<th>Depiction</th>
</tr>
</thead>
<tbody>
<tr>
<td>Keys, commands, messages</td>
<td>Keys, commands, messages</td>
</tr>
<tr>
<td>Navigation in menus, functions of the user interfaces, file paths</td>
<td>File → Save → … OK button</td>
</tr>
<tr>
<td>Accessories</td>
<td>Cable, adapter</td>
</tr>
</tbody>
</table>
# Table of Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>DISCLAIMER OF WARRANTIES AND LIMITATION OF LIABILITY</td>
<td>II</td>
</tr>
<tr>
<td>VERSION DETAILS</td>
<td>II</td>
</tr>
<tr>
<td>LEGAL NOTICES</td>
<td>II</td>
</tr>
<tr>
<td>CONTACT DETAILS</td>
<td>II</td>
</tr>
<tr>
<td>ABOUT THIS MANUAL</td>
<td>III</td>
</tr>
<tr>
<td>Safety levels</td>
<td>iii</td>
</tr>
<tr>
<td>Symbols and formatting</td>
<td>iii</td>
</tr>
<tr>
<td>Tasks</td>
<td>iii</td>
</tr>
<tr>
<td>Lists</td>
<td>iii</td>
</tr>
<tr>
<td>Depictions</td>
<td>iii</td>
</tr>
<tr>
<td>1.0 ABOUT THE DEVICE</td>
<td>1</td>
</tr>
<tr>
<td>1.1 Important device information</td>
<td>1</td>
</tr>
<tr>
<td>1.1.1 Device elements</td>
<td>1</td>
</tr>
<tr>
<td>1.1.2 Type label</td>
<td>1</td>
</tr>
<tr>
<td>1.1.3 Intended use</td>
<td>2</td>
</tr>
<tr>
<td>1.1.4 Conformity</td>
<td>2</td>
</tr>
<tr>
<td>1.2 Device functions</td>
<td>2</td>
</tr>
<tr>
<td>1.2.1 Available models</td>
<td>2</td>
</tr>
<tr>
<td>1.2.2 Scope of supply</td>
<td>3</td>
</tr>
<tr>
<td>1.2.3 Kits</td>
<td>3</td>
</tr>
<tr>
<td>1.2.4 Software and accessories</td>
<td>3</td>
</tr>
<tr>
<td>1.3 Service and support</td>
<td>3</td>
</tr>
<tr>
<td>2.0 SAFETY INFORMATION</td>
<td>4</td>
</tr>
<tr>
<td>2.1 Safety instructions</td>
<td>4</td>
</tr>
<tr>
<td>2.2 CE notes</td>
<td>5</td>
</tr>
<tr>
<td>2.3 FCC notes</td>
<td>5</td>
</tr>
<tr>
<td>2.4 Warranty and liability</td>
<td>6</td>
</tr>
<tr>
<td>3.0 FUNCTIONALITY AND FEATURES</td>
<td>6</td>
</tr>
<tr>
<td>3.1 Functions</td>
<td>6</td>
</tr>
<tr>
<td>3.1.1 Real-time mode</td>
<td>6</td>
</tr>
<tr>
<td>3.1.2 Logging mode</td>
<td>6</td>
</tr>
<tr>
<td>3.1.3 Input/output functions (I/O)</td>
<td>6</td>
</tr>
<tr>
<td>3.1.4 Acceleration sensor</td>
<td>7</td>
</tr>
<tr>
<td>3.1.5 Gyro sensor</td>
<td>7</td>
</tr>
<tr>
<td>3.1.6 GNSS (Global Navigation Satellite System)</td>
<td>7</td>
</tr>
<tr>
<td>3.1.7 eSIM card</td>
<td>7</td>
</tr>
<tr>
<td>3.2 Connectors</td>
<td>7</td>
</tr>
<tr>
<td>3.2.1 Main plug connector</td>
<td>7</td>
</tr>
<tr>
<td>3.2.2 GNSS antenna port</td>
<td>8</td>
</tr>
<tr>
<td>3.2.3 Mobile radio antenna port</td>
<td>8</td>
</tr>
<tr>
<td>3.2.4 Micro-USB port</td>
<td>8</td>
</tr>
</tbody>
</table>
# 4.0 GETTING STARTED

<table>
<thead>
<tr>
<th>Section</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>4.1</td>
<td>Installing software</td>
<td>13</td>
</tr>
<tr>
<td>4.2</td>
<td>Connecting the device</td>
<td>13</td>
</tr>
<tr>
<td></td>
<td>4.2.1 Power supply</td>
<td>13</td>
</tr>
<tr>
<td></td>
<td>4.2.2 CAN</td>
<td>13</td>
</tr>
<tr>
<td></td>
<td>4.2.3 CAN bus termination</td>
<td>14</td>
</tr>
<tr>
<td></td>
<td>4.2.4 Mobile radio and GNSS antenna</td>
<td>14</td>
</tr>
<tr>
<td></td>
<td>4.2.5 Switching the device on/off</td>
<td>14</td>
</tr>
<tr>
<td>4.3</td>
<td>Activation of the device</td>
<td>15</td>
</tr>
<tr>
<td>4.4</td>
<td>Configuring the device</td>
<td>15</td>
</tr>
<tr>
<td></td>
<td>4.4.1 Connecting the device to the PC</td>
<td>15</td>
</tr>
<tr>
<td></td>
<td>4.4.2 Definition of communication settings</td>
<td>15</td>
</tr>
<tr>
<td></td>
<td>4.4.3 Node scan</td>
<td>16</td>
</tr>
<tr>
<td></td>
<td>4.4.4 Customizing the demo configuration file</td>
<td>16</td>
</tr>
<tr>
<td></td>
<td>4.4.5 Loading the configuration to the device</td>
<td>17</td>
</tr>
<tr>
<td>4.5</td>
<td>Connecting the device to the Data platform</td>
<td>18</td>
</tr>
<tr>
<td>4.6</td>
<td>Mounting the device</td>
<td>18</td>
</tr>
</tbody>
</table>

# 5.0 OPERATION

<table>
<thead>
<tr>
<th>Section</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>5.1</td>
<td>Eaton TFX Configurator</td>
<td>20</td>
</tr>
<tr>
<td>5.1.1</td>
<td>Creating object dictionary groups and objects</td>
<td>20</td>
</tr>
<tr>
<td>5.2</td>
<td>Logging mode</td>
<td>21</td>
</tr>
<tr>
<td>5.2.1</td>
<td>Configuring logging mode</td>
<td>21</td>
</tr>
<tr>
<td>5.2.2</td>
<td>Configuring automatic switchover</td>
<td>21</td>
</tr>
<tr>
<td>5.2.3</td>
<td>Configuring variables for CAN communication</td>
<td>22</td>
</tr>
<tr>
<td></td>
<td>5.2.3.1 Receiving J1939 messages with the PGN 61444</td>
<td>23</td>
</tr>
<tr>
<td></td>
<td>5.2.3.2 Example 1: Log all data bytes every 60 seconds</td>
<td>24</td>
</tr>
<tr>
<td></td>
<td>5.2.3.3 Example 2: Log specific data bytes under certain conditions</td>
<td>25</td>
</tr>
<tr>
<td>5.2.4</td>
<td>Logging GNSS position data</td>
<td>28</td>
</tr>
<tr>
<td>5.2.5</td>
<td>Configuring the logging of internal variables</td>
<td>28</td>
</tr>
<tr>
<td>5.2.6</td>
<td>Evaluating logged data on the data platform</td>
<td>29</td>
</tr>
<tr>
<td>5.3</td>
<td>Real-time mode</td>
<td>30</td>
</tr>
<tr>
<td>5.3.1</td>
<td>Configuring real-time mode</td>
<td>30</td>
</tr>
<tr>
<td>5.3.2</td>
<td>Creating a real-time connection and evaluating CAN messages</td>
<td>30</td>
</tr>
<tr>
<td>5.3.3</td>
<td>Setting a reception filter</td>
<td>30</td>
</tr>
<tr>
<td>5.4</td>
<td>File transfer</td>
<td>31</td>
</tr>
<tr>
<td>5.4.1</td>
<td>File transfer</td>
<td>31</td>
</tr>
<tr>
<td>5.4.2</td>
<td>File transfer restrictions</td>
<td>31</td>
</tr>
<tr>
<td>5.5</td>
<td>Encrypted data transfer</td>
<td>31</td>
</tr>
<tr>
<td>5.6</td>
<td>Important device variables</td>
<td>31</td>
</tr>
</tbody>
</table>
6.0 TROUBLESHOOTING AND MAINTENANCE 46

6.1 Remedies ............................................................................................................................................................ 46

6.1.1 Support request ........................................................................................................................................ 46

6.1.2 Connection problems to the Data platform ......................................................................................... 47

6.2 Maintenance....................................................................................................................................................... 48

7.0 PACKAGING AND TRANSPORT 48

8.0 DISPOSAL 49

8.1 Regulations in the European Union ..................................................................................................................... 49

9.0 ANNEX 49

9.1 Technical drawings ............................................................................................................................................ 49

9.2 Technical data .................................................................................................................................................... 50

9.2.1 Mechanical data ........................................................................................................................................ 50

9.2.2 Electrical data ............................................................................................................................................ 50

9.2.3 Interfaces .................................................................................................................................................. 50

9.2.4 Protocols ................................................................................................................................................... 51

9.2.5 Status indicators ..................................................................................................................................... 51

9.3 Certification and qualification ............................................................................................................................ 51

LIST OF TABLES 52

LIST OF FIGURES 53
1.0 About the device

This chapter gives an overview of the device operating elements and functions as well as the intended use of the device. Additionally, it provides an overview of the model variants available and certificates.

For more information, see chapter Annex.

1.1 Important device information

1.1.1 Device elements

1. LED ON
2. LED STATUS
3. Type label
4. Housing
5. Mobile radio antenna port
6. GNSS antenna port
7. Micro-USB port with protective plug
8. Main plug connector
9. Mounting Holes

INFORMATION

Not all model variants feature the antenna ports. For more information, see chapter Available models

1.1.2 Type label

The device type label is located on the front of the housing and provides the following information:

1. Protection class
2. Hardware version
3. Power supply
4. IC-ID
5. FCC-ID
6. Traceability code
7. Disposal symbol
8. Mfg. country of origin
9. ECE certification mark
10. CE mark
11. Hardware supplier part number
12. Serial number
13. IMEI number
14. Eaton part number
15. Model designation

NOTICE

Use of solvents on the product label can remove or destroy product information.

• Keep solvent-containing substances away from label.

INFORMATION

The device’s type label contains important information.

• Do not remove the type label.
1.1.3 Intended use

The device is used to wirelessly transmit CAN data from a vehicle or machine according to the GSM and UMTS standards. GPRS, EDGE, and HSPA are supported.

In interface mode, CAN data can be transmitted to other devices such as PCs, smartphones or tablets for display or evaluation.

Depending on the model, the device features two external antenna ports. You can connect a GNSS antenna and a mobile communications antenna to the external antenna ports.

The device is suitable for use in mobile and stationary systems for industry, small businesses, and in agricultural and forestry machinery.

The device can be used in environments that require protection class IP6K7 and mounted as specified herein.

**INFORMATION**

Protection class IP6K7 is only ensured when all the device connectors except the micro-USB port are provided with plug connectors or corresponding protection caps / protection plugs.

Only use the device within the permitted temperature range and the other parameters specified in the technical data.

Any use other than that described under Intended use is considered to be not intended use.

**MISUSE**

The device does not comply with Directive 2014/34/EU and may not be used in potentially explosive areas.

**QUALIFIED PERSONNEL**

The device must only be put into operation by qualified technicians and electricians with advanced knowledge of electrical engineering and fieldbus systems.

The specialist personnel must know the contents of this manual and have access to the manual at all times.

**NOTICE**

Property damage.

Any defective device must be inspected and repaired by a trained Eaton service technician.

- Do not open the device housing yourself.

1.1.4 Conformity

For details of the corresponding approval tests, see chapter Certification and qualification.

The device meets the requirements of the following standards and legal requirements:

**Compliance with CE**

This device complies with the directives, standards, and normative documents listed in the chapter Certification and qualification.

**Compliance with FCC**

This device complies with Part 15 of the FCC rules. Operation is subject to the following conditions:

- The device may not cause harmful interference.
- The device must accept any interference received, including interference that may cause undesired operation.

See chapter Certification and qualification

**Compliance with E1**

This device has been approved by the KBA (Kraftfahrtbundesamt, Federal Office for Motor Traffic) as compliant with Regulation No. 10. See Chapter Certification and qualification.

**INFORMATION**

For more information about compliance, see the Annex of this Device Manual. See chapter Certification and qualification.

Should you have any questions, simply contact the support team. See chapter Service and support.

1.2 Device functions

The available models differ in the interfaces they offer.

**TFX Internal Antenna**

With this device, you can log position data and transmit and receive CAN data via a mobile phone network. The CAN data can be transmitted directly (real-time mode) or it can be logged and transmitted at a later time. In logging mode, the CAN data is saved to the device and can subsequently be transmitted.

**TFX External Antenna**

The device has the same functions as the TFX Internal Antenna, but instead of the integrated antenna, it has external antenna ports for mobile radio and position tracking (GNSS).

1.2.1 Available models

**Table 1: Available TFX models**

<table>
<thead>
<tr>
<th>Model</th>
<th>Eaton Part number</th>
<th>Battery</th>
<th>CAN</th>
<th>Ext. antenna</th>
<th>WLAN / Bluetooth</th>
<th>Mobile radio</th>
</tr>
</thead>
<tbody>
<tr>
<td>Internal Antenna</td>
<td>102EC77303A</td>
<td>No</td>
<td>1</td>
<td>No</td>
<td>No</td>
<td>3G</td>
</tr>
<tr>
<td>External Antenna</td>
<td>102EC77304A</td>
<td>No</td>
<td>1</td>
<td>Yes</td>
<td>Yes</td>
<td>3G</td>
</tr>
</tbody>
</table>
1.2.2 Scope of supply

> TFX
> Product information sheet with SIMPLIFIED EU DECLARATION OF CONFORMITY

1.2.3 Kits

The kits listed contain all hardware components required for putting into operation.

Before you can use the data platform, you must obtain corresponding access. The setup of the new account for the data platform is included in the STARTER KIT.

Table 2: Required hardware components for TFX operation

<table>
<thead>
<tr>
<th>Model Material</th>
<th>Internal Antenna</th>
<th>External Antenna</th>
</tr>
</thead>
<tbody>
<tr>
<td>TFX</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>Starter cable for device setup</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>TFX support tool</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>USB cable (TFX support tool)</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>CAN-Bus termination resistor 120Ω</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>Power supply with changeable plugs (US, EU, UK, AU)</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>USB cable (bootloader / firmware-update)</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>USB cable (debugging / diagnosis)</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>Mounting kit M5</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>Antenna LTE GNSS DA 3M0 FAKRA-D FAKRA-C FA</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>Order number for HARDWARE KIT</td>
<td>102EC77300A 102EC77301A</td>
<td>✔</td>
</tr>
<tr>
<td>Order number for STARTER KIT</td>
<td>102EC77302A 102EC77302A</td>
<td>✔</td>
</tr>
</tbody>
</table>

INFORMATION

The HARDWARE KIT only includes the TFX and mounting accessories. We recommend that customers without an existing user account at the Data platform should order the STARTER KIT. The STARTER KIT includes the hardware and the initial account setup at the Data platform.

1.2.4 Software and accessories

The software can be located at: Eaton.com/TFX

SOFTWARE

Table 3: Required software for TFX operation

<table>
<thead>
<tr>
<th>Software</th>
<th>Part number</th>
</tr>
</thead>
<tbody>
<tr>
<td>EATON Configurator</td>
<td>Eaton Installer Package</td>
</tr>
<tr>
<td>PROEMION Dashboard</td>
<td>PROEMION Tools CD</td>
</tr>
<tr>
<td>PROEMION Firmware Programmer</td>
<td>PROEMION Tools CD</td>
</tr>
<tr>
<td>PROEMION PDC Builder</td>
<td>PROEMION Tools CD</td>
</tr>
</tbody>
</table>

ACCESSORIES

Table 4: TFX available accessories

<table>
<thead>
<tr>
<th>Accessories / description</th>
<th>Part number</th>
</tr>
</thead>
<tbody>
<tr>
<td>TFX SERVICE TOOL</td>
<td>102EC991110A</td>
</tr>
<tr>
<td>CAN-PC gateway for configuration and test purposes</td>
<td>102EC991110A</td>
</tr>
<tr>
<td>CONNECTOR KIT</td>
<td>102EC94102A</td>
</tr>
<tr>
<td>MT II 14-pin socket housing, 14 MT II contact type A, 14 MT II gray single-wire seals, 14 blind plugs</td>
<td>102EC94102A</td>
</tr>
<tr>
<td>TFX EXTERNAL ANTENNA</td>
<td>102EC99111A</td>
</tr>
</tbody>
</table>

1.3 Service and support

For more information, go to our website at: www.Eaton.com/TFX
2.0 Safety information
This chapter contains important information on how to avoid life-threatening situations and injuries and how to prevent product damage.

2.1 Safety instructions

⚠️ DANGER
Failure of safety-related functions due to deficient data transmission.
Severe injury or death.

The device operates using radio signals and is not authorized for use in safety-related applications. Insufficient mobile network availability, interference or malfunctions of the device can cause faulty data transmission. Because of this, data transmission cannot be guaranteed at all times and under all conditions.

- Never operate this device in machines or applications where life depends on the fault-free operation of this device.
- Never rely solely on wireless devices for essential communications.
- The device is designed to be used in systems which must be checked for conformity with the respective valid legal requirements prior to putting into operation. The integrator of the device is responsible for ensuring that the final system complies with all regional regulations and requirements.

⚠️ DANGER
Failure of communications systems in aircraft due to radio-frequency energy.
Severe injury or death.

- Disconnect the power supply to the device before entering the aircraft.
- Make sure the device cannot be switched on inside the aircraft.
- Note the information in chapter Power management.

⚠️ DANGER
Danger of explosion due to the operation of electrical equipment in potentially explosive atmospheres.
Severe injury or death.

- Observe the applicable regulations and precautions for potentially explosive areas.
- Do not mount the antenna in the close proximity of easily ignited substances (e.g. fuel tanks) and insufficiently shielded electronic devices.

⚠️ WARNING
Danger of interference with medical equipment caused by radio frequency (RF) energy.
Severe injury or death.

Medical equipment may be sensitive to RF energy.
The functioning of cardiac pacemakers, other implanted medical devices, and hearing aids can be affected if the TFX is located too close to the medical devices.

- Observe the local regulations for use of mobile radio devices in hospitals or other medical facilities. Disconnect the power supply to the device when local regulations in sensitive areas require that you do so.
- If you use a cardiac pacemaker or other medical device, do not come within the close vicinity of the switched-on TFX and its antenna.
- If in doubt about potential danger, contact a physician or the manufacturer of the medical equipment to verify that it is properly shielded.

⚠️ WARNING
Danger to life due to electric shock!
Severe injury or death.

- Never use the device if you suspect damage to the power supply unit or the device, or if there is visible damage to the power supply unit or the device.

⚠️ WARNING
Danger to life due to electric shock!
Severe injury or death.

- Never carry out repairs to the device yourself. Contact the support service. The device does not contain any parts that can be repaired or maintained by the user.

⚠️ WARNING
Overload damage due to malfunction.
Severe injury or death.

- To limit power in the event of malfunction, secure the DC power supply circuit during installation with an external 2 A fuse.

⚠️ CAUTION
Health hazards of radio-frequency energy
Slight or medium injury.

- During operation, observe a distance of at least 20 cm between the antennas and personnel.
NOTICE
Interference with electronic equipment caused by radio-frequency energy.

• Do not use the device with damaged cables or plugs. Cables and plugs must always be shielded.
• Observe all special regulations and disconnect the power supply to the TFX if its use is prohibited or if you have doubts as to whether operation can cause interference or dangers.

NOTICE
Property damage.

• The device must be installed, connected, and commissioned by a qualified technician.
• Disconnect the device completely before handling it.
• Also disconnect any independently supplied output load circuits.
• Provide all the device connectors with plugs and any protection caps required to ensure protection class IP6K7.
• Only install the device in the installation position shown in chapter Mounting the device.
• Never immerse the device in water or other liquids.
• The device must only be repaired by the manufacturer.
• Keep substances that contain solvents away from the type label.
• Pay attention that all plug and cable connections are made with the connectors correctly aligned and without the use of excessive force.

2.2 CE notes
The devices described in this device manual may only be used in mobile or stationary systems in which the distance between antennas and persons is at least 20 cm. Furthermore, antennas may only be operated if the correct horizontal distance between them and other antennas or transmitters is observed.

NOTICE
Loss of CE conformity is possible.

Only use antennas with a maximum gain of:

- TFX External Antenna:
  - 2.9 dBi (900 MHz, GSM 900 band / UMTS FDD-8 band)
  - 7.8 dBi (1800 MHz, GSM 1800 band)
  - 11.8 dBi (2100 MHz, UMTS FDD-1 band)

Changes or modifications to this device not expressly approved by the manufacturer can void the user’s authority to operate the device under CE rules.

INFORMATION
The horizontal distance between antennas can be calculated for every radio signal.

The distance between two antennas should always be greater than 1/4 of the wavelength, but not a multiple of the wavelength. If you use several antennas with different radio signals from each other, the distance of the antenna with the lowest frequency range must be observed.

GNSS:
Frequency range 1.227 GHz, wavelength 33.33 cm
(1/4 = 6.11 cm)

2.3 FCC notes
The devices described in this device manual may only be used in mobile or stationary systems in which the distance between antennas and persons is at least 20 cm. The antennas must further not be co-located or operated in conjunction with any other antennas or transmitters.

NOTICE
This device has been tested and found to comply with the limits for a Class B digital device pursuant to part 15 of the FCC rules. These limits are designed to provide adequate protection against harmful interference in a residential installation. This device generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause interference to radio communications. There is no guarantee that interference will not occur in a particular installation. If this device does cause interference to radio or television reception, which can be determined by switching the device on and off, the user is advised to try to correct the interference by one or more of the following measures:

• Realign the receiving antenna or put it in a different place.
• Increase the distance between the device and the receiver.
• Connect the device and the receiver to different supply circuits.
• Consult the dealer or an experienced radio/TV technician for help.
### NOTICE

Loss of FCC certification possible.

Only use antennas with a maximum gain of:

- **TFX External Antenna**
  - 3.4 dBi (850 MHz)
  - 1.5 dBi (1900 MHz).

Changes or modifications to the device not expressly approved by the manufacturer can void the user’s authority to operate the device under FCC rules.

### 2.4 Warranty and Liability

In order to consistently bring you the highest quality, full featured products, we reserve the right to change our specifications and designs at any time.

A limited warranty is given with these Eaton products. Please see our website for details.

http://www.eaton.com/Eaton/ProductsServices/Hydraulics/WarrantyTermsConditions/PCT_612027

### 3.0 Functionality and Features

This chapter contains information on device functionality and features. It describes in detail the operating modes, connectors, cables, pin assignments, interfaces, and indicator elements.

### 3.1 Functions

#### Table 5: Listed functions for TFX models

<table>
<thead>
<tr>
<th>Function</th>
<th>TFX Internal Antenna</th>
<th>TFX External Antenna</th>
</tr>
</thead>
<tbody>
<tr>
<td>CAN-CAN-Bluetooth / WLAN bridge</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>CAN-Bluetooth/WLAN interface</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>Battery</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>Antenna (internal / external)</td>
<td>int.</td>
<td>ext.</td>
</tr>
<tr>
<td>Mobile radio (3G/4G)</td>
<td>3G</td>
<td>3G</td>
</tr>
<tr>
<td>Real-time mode</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Logging mode</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Input/output functions</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Acceleration sensor</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Gyro sensor</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>CAN connectors</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>GNSS</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>eSIM card</td>
<td>Yes</td>
<td>Yes</td>
</tr>
</tbody>
</table>

#### 3.1.1 Real-time mode

In real-time mode, CAN messages are transmitted bidirectionally.

With the device, you can use CAN interfaces to transmit process data such as machine parameters during ongoing operations to the Data platform. Depending on the device features, you can transmit data from the GNSS receiver and the input/output functions and pass them on via the CAN bus.

Data is transmitted constantly and can be evaluated in close to real-time. This function requires a permanent link between the device and the user software or the Data platform.

#### 3.1.2 Logging mode

In logging mode, the device logs CAN messages, GNSS data, and internal variables such as the values of the acceleration or gyro sensors. All logged data is saved to an internal, nonvolatile memory and sent to the Data platform.

With the device, you can log process data such as machine parameters during ongoing operation via CAN interfaces. Depending on the device features, you can process data from the GNSS receiver and the input/output functions and send and log them via the CAN bus.

#### 3.1.3 Input/output functions (I/O)

The device features additional input/output functions (3 analog inputs, 1 digital output). You can use the input function for instance to log status information from devices or machines as well as to directly determine and monitor
switch and key states. The data determined from the input/output functions can be visualized or forwarded via the CAN bus.

### 3.1.4 Acceleration sensor

The acceleration sensor registers and evaluates accelerations in the X, Y, and Z axes, and sends them via the CAN bus.

![Fig 3. Acceleration sensor TFX](image)

### 3.1.5 Gyro sensor

The 3-axis gyro sensor registers and evaluates the angle speeds in the X, Y, and Z axes and sends them to the CAN bus.

![Fig 4. Gyro sensor TFX](image)

### 3.1.6 GNSS (Global Navigation Satellite System)

The device features a GNSS receiver. You can send the position data determined by the GNSS receiver via the CAN bus or the mobile radio network. The receiver can process signals from GPS, GLONASS, and BeiDou satellites. It can process data from two navigation systems simultaneously. This increases the accuracy.

### 3.1.7 eSIM card

The device features an integrated eSIM card. On delivery, the eSIM card already has an eSIM profile with all the necessary communication settings.

---

**INFORMATION**

On delivery, the device’s eSIM card is not yet enabled. After registration of the TFX, enabling the eSIM card can take up to 1 working day.

### 3.2 Connectors

The device features the following connectors:

- 1 main plug connector (14-pin): CAN1 / VCC / GND / AIN1-3 / DOUT
- 1 GNSS antenna port, FAKRA, C-coded in blue (models TFX External Antenna)
- 1 mobile radio antenna port, FAKRA, D-coded in violet (model TFX External Antenna)
- 1 micro-USB port, type AB

#### 3.2.1 Main plug connector

Use the main plug connector to connect the device to the CAN bus and supply it with power. The I/O signals are integrated in the plug connector.

See the following overview for the pin assignment:

**Table 6: Main plug connector pin layout**

<table>
<thead>
<tr>
<th>Pin</th>
<th>Designation</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Terminal 30 / VCC</td>
<td>Power supply</td>
</tr>
<tr>
<td>2</td>
<td>Factory setting 1</td>
<td>Input</td>
</tr>
<tr>
<td>3</td>
<td>Terminal 31 / ground</td>
<td>Power supply</td>
</tr>
<tr>
<td>4</td>
<td>Analog input 1</td>
<td>I/O input</td>
</tr>
<tr>
<td>5</td>
<td>Analog input 2</td>
<td>I/O input</td>
</tr>
<tr>
<td>6</td>
<td>Analog input 3</td>
<td>I/O input</td>
</tr>
<tr>
<td>7</td>
<td>Digital output</td>
<td>I/O output</td>
</tr>
<tr>
<td>8</td>
<td>Terminal 15</td>
<td>I/O output</td>
</tr>
<tr>
<td>9</td>
<td>Factory setting 2</td>
<td>Input</td>
</tr>
<tr>
<td>10</td>
<td>CAN GND</td>
<td>CAN ground</td>
</tr>
<tr>
<td>11</td>
<td>N/A</td>
<td>N/A</td>
</tr>
<tr>
<td>12</td>
<td>N/A</td>
<td>N/A</td>
</tr>
<tr>
<td>13</td>
<td>CAN1-High</td>
<td>CAN, bidirectional</td>
</tr>
<tr>
<td>14</td>
<td>CAN1-Low</td>
<td>CAN, bidirectional</td>
</tr>
</tbody>
</table>
NOTICE
The main plug connector features a reset button (located next to pin 7).

INFORMATION
The pin assignment shown here can vary depending on the model variant. Model variants TFX Internal Antenna and TFX External Antenna devices do not have CAN2 signals.

INFORMATION
The analog inputs operate in a range of 0 VDC to 15 VDC. Optionally, you can use the input as a digital input with a maximum voltage of 36 VDC. The digital output switches to supply voltage on terminal 30 and can only take a maximum load of 500 mA. Provide an external safeguard if this limit is not ensured by the external terminal 30 power supply. Input terminal 15 detects “high” from a voltage of 5.5 V and “low” below a voltage of 2.3 V.

3.2.2 GNSS antenna port
Use the GNSS antenna port to connect the device (model TFX External Antenna) to an active antenna to receive signals from GNSS satellites.

Table 7: GNSS antenna port pin information

<table>
<thead>
<tr>
<th>Pin</th>
<th>Designation</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Ground</td>
<td>Signal ground / shielding</td>
</tr>
<tr>
<td>2</td>
<td>Signal</td>
<td>GNSS signal / supply voltage 3.3 V</td>
</tr>
</tbody>
</table>

The GNSS antenna port is supplied with a voltage of approx. 3.3 V and can supply active antennas with a maximum of 40 mA of power. The port is short-circuit-resistant and recognizes that an antenna is present from a power greater than approx. 2 mA.

CAUTION!
Health hazards of radio-frequency energy.
Slight or medium injury.
• Make sure the device is switched off during installation.

3.2.3 Mobile radio antenna port
Use the mobile radio antenna port to connect the device (model TFX External Antenna) to an antenna to receive mobile radio signals.

Table 8: Mobile radio antenna port pin information

<table>
<thead>
<tr>
<th>Pin</th>
<th>Designation</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Ground</td>
<td>Signal ground / shielding</td>
</tr>
<tr>
<td>2</td>
<td>Signal</td>
<td>Mobile radio</td>
</tr>
</tbody>
</table>

The antenna recognition function recognizes an antenna when the antenna has an integrated diagnosis resistance (10 kOhm).

CAUTION
Health hazards of radio-frequency energy.
Slight or medium injury.
• Make sure the device is switched off during installation.

3.2.4 Micro-USB port
Use the micro-USB port to connect the device to a PC. The micro-USB port is used for diagnoses, bootloader and firmware updates.

For instructions on how to perform diagnoses, see chapter Diagnosis via micro-USB port.

For instructions on how to update the bootloader and the firmware, see chapter Firmware update.

Table 9: Micro-USB port pin information

<table>
<thead>
<tr>
<th>Pin</th>
<th>Designation</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>VBUS</td>
<td>Input</td>
</tr>
<tr>
<td>2</td>
<td>D-</td>
<td>Bidirectional</td>
</tr>
</tbody>
</table>
### Functionality and features

<table>
<thead>
<tr>
<th>3</th>
<th>D+</th>
<th>Bidirectional</th>
</tr>
</thead>
<tbody>
<tr>
<td>4</td>
<td>ID</td>
<td>Input (0=boot mode, 1/open=USB device)</td>
</tr>
<tr>
<td>5</td>
<td>Ground</td>
<td>USB power supply / reference ground</td>
</tr>
</tbody>
</table>

#### NOTICE

Protection class IP6K7 is also ensured when no USB cable is connected.

However, to protect it against dirt, always insert the corresponding protective plug into the micro-USB port.

#### NOTICE

The device is self-powered. The micro-USB port corresponds with the USB 2.0 fullspeed device mode. The device is not supplied with power via the VBUS.

The use of the ID pin does not comply with the USB standard because the micro-USB port does not support USB-OTG. If a type-A USB cable is connected, the device stays in bootloader mode.

#### NOTICE

Risk of property damage

Pay attention that the USB plug is correctly aligned to the USB port on the computer before being plugged in and that it is plugged in without using excessive force. Incorrect alignment during connection or the use of excessive force could cause damage to the USB port.

#### INFORMATION

To perform debugging or diagnosis, you need the cable USB cable, USB-A on micro-USB-B, 1.6 m (contained within the Starter Kit).

### 3.3 Indicator elements (LED)

Two LEDs are installed on the front of the device to indicate functions and status.

#### INFORMATION

The LEDs have the colors red, green, and blue. When several colors are active simultaneously, the LEDs also light up in magenta, orange, or turquoise.

The following tables show possible LED indications:

#### ON LED

The ON LED indicates the power supply status.

<table>
<thead>
<tr>
<th>Color</th>
<th>Status</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off</td>
<td>-</td>
<td>Device switched off or in sleep mode</td>
</tr>
<tr>
<td>Green</td>
<td>On</td>
<td>Device switched on, terminal 30 voltage in permitted range</td>
</tr>
<tr>
<td>Red</td>
<td>On</td>
<td>Device switched on, terminal 30 voltage outside permitted range, device is in battery operation</td>
</tr>
<tr>
<td>Green</td>
<td>Flashing</td>
<td>Device in diagnosis or update mode</td>
</tr>
</tbody>
</table>

#### STATUS LED

The STATUS LED indicates the operating status of the active connections. The various colors are displayed according to priority, from 5 (low) to 1 (top).

If several modes are active simultaneously, the STATUS LED always indicates the status with the highest priority (smallest number).

<table>
<thead>
<tr>
<th>Color</th>
<th>Status</th>
<th>Connection</th>
<th>Priority</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>Device switched off.</td>
</tr>
<tr>
<td>Green</td>
<td>On</td>
<td>Various</td>
<td>-</td>
<td>Connected to PROEMION server.</td>
</tr>
<tr>
<td>Blue</td>
<td>On</td>
<td>Mobile radio internet</td>
<td>1</td>
<td>Not connected to PROEMION server.</td>
</tr>
<tr>
<td>Red</td>
<td>On</td>
<td>CAN 1</td>
<td>2</td>
<td>Faulty connection.</td>
</tr>
<tr>
<td>Magenta</td>
<td>On</td>
<td>GNSS</td>
<td>4</td>
<td>No position / antenna detected.</td>
</tr>
<tr>
<td>White</td>
<td>On</td>
<td>WLAN Bluetooth</td>
<td>5</td>
<td>Not connected to any network / device.</td>
</tr>
</tbody>
</table>

#### INFORMATION

If the device is working fault-free with the current connection (CAN1, mobile radio, GNSS), the STATUS LED lights up green.

When the connection is active, e.g. communication with the data platform, the STATUS LED flashes. ("Activity flash").

In the event of a fault, the STATUS LED only displays the status with the highest priority.
Functionality and features

Example: The device does not recognize any GNSS position (priority 4 = magenta) and has no mobile radio connection (priority 1 = blue). The STATUS LED lights up blue.

**LEDS DURING CERTAIN OPERATING MODES**

The LEDs indicate certain active operating modes and processes.

---

**INFORMATION**

The LED statuses shown in the table are examples.

The illumination of the LEDs can deviate from this depending on the use purpose and conditions.

Table 12: LED operating modes, status indications, and their meaning

<table>
<thead>
<tr>
<th>LED</th>
<th>Status</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>ON STATUS</td>
<td></td>
<td>Configuration update in progress via the CAN interface.</td>
</tr>
<tr>
<td>ON STATUS</td>
<td></td>
<td>Device is in Logging mode, receives configured CAN messages (orange flash) and transmits the logged messages to the Data platform (blue flash).</td>
</tr>
<tr>
<td>ON STATUS</td>
<td></td>
<td>Active data transmission in real-time mode.</td>
</tr>
<tr>
<td>ON STATUS</td>
<td></td>
<td>Device initializing after switching on.</td>
</tr>
<tr>
<td>ON STATUS</td>
<td></td>
<td>Configuration update in progress via the Data platform.</td>
</tr>
<tr>
<td>ON STATUS</td>
<td></td>
<td>Remote firmware update in progress via the Data platform.</td>
</tr>
<tr>
<td>ON STATUS</td>
<td></td>
<td>Device reset via slide switch on the D-sub port (CAN1).</td>
</tr>
<tr>
<td>ON STATUS</td>
<td></td>
<td>Transmission of the GPS position and the keep-alive message. Display varies depending on configured polling interval.</td>
</tr>
</tbody>
</table>

---

### 3.4 Cables

#### 3.4.1 Start cable for main plug connector

The cable CLM3 start cable 6 open, 2 dsub, 1 pw, 2 m (contained within the Starter Kit) features the following connectors and open individual wires:

- 1 micro timer II socket, 14-pin, female
- 2 D-sub, 9-pin, female (CAN1)
- 1 power connector

**Micro timer II socket (14-pin, female)**

<table>
<thead>
<tr>
<th>Pin</th>
<th>Designation</th>
<th>Color</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Terminal 30 / VCC</td>
<td>White</td>
<td>Power supply (permanent positive plus vehicle battery)</td>
</tr>
<tr>
<td>2</td>
<td>Factory setting 1</td>
<td>Brown</td>
<td>Input</td>
</tr>
<tr>
<td>3</td>
<td>Terminal 31 / ground</td>
<td>Green</td>
<td>Power supply</td>
</tr>
<tr>
<td>4</td>
<td>Analog input 1</td>
<td>Yellow</td>
<td>I/O input</td>
</tr>
<tr>
<td>5</td>
<td>Analog input 2</td>
<td>Gray</td>
<td>I/O input</td>
</tr>
<tr>
<td>6</td>
<td>Analog input 3</td>
<td>Pink</td>
<td>I/O input</td>
</tr>
<tr>
<td>7</td>
<td>Digital output</td>
<td>Blue</td>
<td>I/O output</td>
</tr>
<tr>
<td>8</td>
<td>Terminal 15</td>
<td>Red</td>
<td>Input (ignition signal)</td>
</tr>
<tr>
<td>9</td>
<td>Factory setting 2</td>
<td>Black</td>
<td>Input</td>
</tr>
<tr>
<td>10</td>
<td>CAN2-GND</td>
<td>Violet</td>
<td>-</td>
</tr>
<tr>
<td>11</td>
<td>CAN2-High</td>
<td>Gray-pink</td>
<td>CAN, bidirectional</td>
</tr>
<tr>
<td>12</td>
<td>CAN2-Low</td>
<td>Red-blue</td>
<td>CAN, bidirectional</td>
</tr>
<tr>
<td>13</td>
<td>CAN1-High</td>
<td>White-green</td>
<td>CAN, bidirectional</td>
</tr>
<tr>
<td>14</td>
<td>CAN1-Low</td>
<td>Brown-green</td>
<td>CAN, bidirectional</td>
</tr>
</tbody>
</table>

**INFORMATION**

The open end connectors are numbered on the strand ends.

CAN2 not available with the current product offering.

The polarity also applies for the following cable:

- CLM3 start cable 6 open, 2 dsub, 1 pw, 2 m (contained within the Starter Kit)

**Individual open end wires**

<table>
<thead>
<tr>
<th>Designation</th>
<th>Color</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Terminal 31 / ground</td>
<td>Green</td>
<td>Power supply</td>
</tr>
<tr>
<td>Analog input 1</td>
<td>Yellow</td>
<td>I/O input</td>
</tr>
<tr>
<td>Analog input 2</td>
<td>Gray</td>
<td>I/O input</td>
</tr>
<tr>
<td>Analog input 3</td>
<td>Pink</td>
<td>I/O input</td>
</tr>
<tr>
<td>Digital output</td>
<td>Blue</td>
<td>I/O output</td>
</tr>
<tr>
<td>Terminal 15</td>
<td>Red</td>
<td>Input (ignition signal)</td>
</tr>
</tbody>
</table>

Start cable for main plug connector, individual wires open
Power connector, low voltage coupling

<table>
<thead>
<tr>
<th>Pin</th>
<th>Designation</th>
<th>Color</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Terminal 31 / ground</td>
<td>Green</td>
<td>Power supply</td>
</tr>
<tr>
<td>2</td>
<td>Terminal 30 / VCC</td>
<td>White</td>
<td>Power supply</td>
</tr>
</tbody>
</table>

Start cable for main plug connector, power supply cable

D-sub connector, female, 9-pin (CAN1)

<table>
<thead>
<tr>
<th>Pin</th>
<th>Designation</th>
<th>Color</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>not assigned</td>
<td>-</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>CAN1-Low</td>
<td>Brown-green</td>
<td>CAN, bidirectional</td>
</tr>
<tr>
<td>3</td>
<td>not assigned</td>
<td>-</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>not assigned</td>
<td>-</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>not assigned</td>
<td>-</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Terminal 31 / ground</td>
<td>Green</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>CAN1-High</td>
<td>White-green</td>
<td>CAN, bidirectional</td>
</tr>
<tr>
<td>8</td>
<td>not assigned</td>
<td>-</td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>Terminal 30 / VCC</td>
<td>White</td>
<td>Power supply</td>
</tr>
</tbody>
</table>

Start cable for main plug connector, D-sub connector (CAN1)

The connector D-sub connector (CAN1) also features a slide switch for a factory reset.

D-sub connector, female, 9-pin (CAN2)

<table>
<thead>
<tr>
<th>Pin</th>
<th>Designation</th>
<th>Color</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>not assigned</td>
<td>-</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>CAN2-Low</td>
<td>Red-blue</td>
<td>CAN, bidirectional</td>
</tr>
<tr>
<td>3</td>
<td>not assigned</td>
<td>-</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>not assigned</td>
<td>-</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>not assigned</td>
<td>-</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>CAN2-GND</td>
<td>Violet</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>CAN2-High</td>
<td>Gray-pink</td>
<td>CAN, bidirectional</td>
</tr>
<tr>
<td>8</td>
<td>not assigned</td>
<td>-</td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>not assigned</td>
<td>-</td>
<td></td>
</tr>
</tbody>
</table>

Start cable for main plug connector, D-sub connector (CAN2)

3.4.2 USB connector cable (firmware update)

The USB cable, USB A-micro USB A, 1.8-2 m (PROEMION part number 136 000 199) is intended for firmware or bootloader updates and has the following connectors:

> 1 micro-USB-A, male
> 1 USB-A, male

Micro-USB-A connector, male

<table>
<thead>
<tr>
<th>Pin</th>
<th>Designation</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>VBUS</td>
<td>USB power supply</td>
</tr>
<tr>
<td>2</td>
<td>D-</td>
<td>Bidirectional</td>
</tr>
<tr>
<td>3</td>
<td>D+</td>
<td>Bidirectional</td>
</tr>
<tr>
<td>4</td>
<td>ID</td>
<td>Ground, output</td>
</tr>
<tr>
<td>5</td>
<td>Ground</td>
<td>USB power supply</td>
</tr>
</tbody>
</table>

USB cable, USB A-micro USB A, 1.8-2 m, micro-USB-A, male
Functionality and features

<table>
<thead>
<tr>
<th>Pin</th>
<th>Designation</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>VBUS</td>
<td>USB power supply</td>
</tr>
<tr>
<td>2</td>
<td>D-</td>
<td>Bidirectional</td>
</tr>
<tr>
<td>3</td>
<td>D+</td>
<td>Bidirectional</td>
</tr>
<tr>
<td>4</td>
<td>Ground</td>
<td>USB power supply</td>
</tr>
</tbody>
</table>

USB cable, USB A-micro USB A, 1.8-2 m, USB-A, male

---

**NOTICE**

If you start the device with a connected USB-cable, USB A-micro USB A, 1.8 - 2 m, neither of the two LEDs on the device light up.

---

**INFORMATION**

With the micro-USB type-A cable, the pin ID is drawn to GND when the device is switched on. This activates the MCU-internal bootloader.

### 3.4.3 USB connector cable (diagnosis)

The USB cable, USB-A on micro-USB-B, 1.6 m (included in Starter Kit) is intended for debugging and for diagnosis of the device. It has the following connectors:

> 1 micro-USB-B, male
> 1 USB-A, male

<table>
<thead>
<tr>
<th>Pin</th>
<th>Designation</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>VBUS</td>
<td>USB power supply</td>
</tr>
<tr>
<td>2</td>
<td>D-</td>
<td>Bidirectional</td>
</tr>
<tr>
<td>3</td>
<td>D+</td>
<td>Bidirectional</td>
</tr>
<tr>
<td>4</td>
<td>ID</td>
<td>Output (ID is undefined)</td>
</tr>
<tr>
<td>5</td>
<td>Ground</td>
<td>USB power supply</td>
</tr>
</tbody>
</table>

USB cable, USB-A on micro-USB-B, 1.6 m, micro-USB-A, male
4.0 Getting started

This chapter describes the first steps required for deploying the device. Furthermore, it contains useful information on how to connect, configure, and mount the device.

4.1 Installing software

Use the EATON Configurator software to configure the device.

You can evaluate the data with the Data platform or PROEMION Dashboard.

You can use PROEMION Converter to convert the logged data. You can convert the data into a comma-separated text file (.csv) or provide the position data for use in Google Earth or Google Maps (.kml).

Use the PROEMION Firmware Programmer software for firmware updates.

The software can be found at: www.Eaton.com/TFX

<table>
<thead>
<tr>
<th>Software</th>
<th>Path to software</th>
</tr>
</thead>
<tbody>
<tr>
<td>EATON configurator</td>
<td><a href="http://www.Eaton.com/TFX">www.Eaton.com/TFX</a></td>
</tr>
<tr>
<td>PROEMION dashboard</td>
<td>PROEMION tools CD\PROEMION tools software\software\PROEMION dashboard</td>
</tr>
<tr>
<td>PROEMION firmware programmer</td>
<td>PROEMION tools CD\PROEMION tools software\software\PROEMION firmware programmer</td>
</tr>
<tr>
<td>PROEMION PDC Builder</td>
<td>PROEMION tools CD\PROEMION tools software\software\PROEMION PDC Builder</td>
</tr>
<tr>
<td>Drivers</td>
<td>PROEMION tools CD\USB drivers</td>
</tr>
</tbody>
</table>

Execute the relevant application file (setup.exe, install.bat or similar) and follow the instructions on the screen to install the software on your PC.

4.2 Connecting the device

⚠️ WARNING

Overload damage due to malfunction.

Severe injury or death.

- To limit power in the event of malfunction, secure the DC power supply circuit with an external 2 A fuse.

NOTICE

Property damage.

- The device must be installed, connected, and commissioned by a qualified technician.
- Ensure the power supply is disconnected before connecting the device.
- Only use components from the starter kits or the accessories supplied. See chapters Kits and Software and accessories.

4.2.1 Power supply

The main plug connector supplies the device with power.

If you use the power supply unit from the kit, make sure you use the country adapter for your country.

![Fig 5. Power supply unit with country adapters](image)

4.2.2 CAN

Connect the device interfaces to the CAN bus whose data you want to visualize. For test purposes, connect the device to a PC using a communication gateway (e.g. TFX Service Tool).

The CAN connection terminal CAN-High and CAN-Low signals must match the signals of the connector on the device. You can connect Ground of the power supply connector with CAN1-GND because the CAN1 interface has no galvanic isolation.

The following table provides an overview of some CAN baud rates in relation to the bus length:
Table 13: CAN baud rate and corresponding maximum bus length

<table>
<thead>
<tr>
<th>CAN baud rate</th>
<th>Maximum bus length</th>
</tr>
</thead>
<tbody>
<tr>
<td>800 kbit/s</td>
<td>50 m</td>
</tr>
<tr>
<td>500 kbit/s</td>
<td>100 m</td>
</tr>
<tr>
<td>250 kbit/s</td>
<td>250 m</td>
</tr>
<tr>
<td>125 kbit/s</td>
<td>500 m</td>
</tr>
<tr>
<td>50 kbit/s</td>
<td>1,000 m</td>
</tr>
</tbody>
</table>

4.2.3 CAN bus termination

In any bus system, signal reflections at the end of a wire or cable can cause interference which can in turn cause transmission errors. To minimize these reflections, place a terminator at each end of transmission lines. The terminating resistance between CAN-High and CAN-Low must match the characteristic impedance of the transmission lines.

In CAN bus networks, normally unshielded, twisted cable pairs are used for signal transmission. The characteristic impedance of the transmission lines is roughly 120 Ω. The terminator between CAN-High and CAN-Low must be 120 Ω.

4.2.4 Mobile radio and GNSS antenna

The TFX External Antenna model variant features external antenna ports for mobile radio and GNSS signals.

The antenna ANT LTE GNSS DA 3M0 FAKRA-D FAKRA-C FA (part number 102EC99111A) features a port for mobile radio signals (FAKRA-D) and a port for GNSS signals (FAKRA-C).

**MOBILE RADIO CONNECTOR**

Connect the antenna’s FAKRA-D plug (violet) to the device’s FAKRA-D port (violet).

**NOTICE**

Property damage

The device or antenna could be damaged.

- Only use antennas with a maximum gain as specified in the technical data. See chapter Technical data.

**GNSS CONNECTOR**

Connect the antenna’s FAKRA-C plug (blue) to the device’s FAKRA-C port (blue).

**NOTICE**

Property damage

The device or antenna could be damaged.

- Only use active GNSS antennas with LNA, gain max. 25 dBi, voltage 3.3 VDC, current max. 30 mA.

**INFORMATION**

Mount the GNSS antenna so that it is level with the horizon and has full view of the sky above.

4.2.5 Switching the device on/off

The device does not have an on/off switch.

To switch it on, connect the device to an active power supply.

To switch it off, disconnect it from the active power supply.

**NOTICE**

Device defect due to power failure.

Destroyed file system on the device. Repair by Eaton necessary.

- Permanently connect terminal 30 to permanent positive plus (vehicle battery) to ensure the device switches off correctly.
- Connect terminal 15 correctly and configure safe shutdown in the “Power Management” field of the device configuration.
- Do not disconnect the device from the power supply until all active processes have been completed.
4.3 Activation of the device

The device features an integrated eSIM card. On delivery, the eSIM card already has an eSIM profile with all the necessary communication settings. Before you can use the device, you must activate the device. You can do so at www.eaton.com/tfxactivation.

After activation, the TFX device is assigned to your Data platform account and the activation of the eSIM card is triggered.

INFORMATION

If you do not have or do not have access to administrator login credentials, contact the salesperson responsible for you or our service support. See chapter Service and support.

INFORMATION

Activation of the eSIM card can take up to one working day.

When activation has been completed, you receive a confirmation by email.

4.4 Configuring the device

The device is delivered with a basic Eaton-default configuration. Customize the configuration according to your needs by defining the CAN messages to be logged.

You can use the CAN interface or the Data platform to transfer a new device configuration to the device. In the following, configuration using the CAN interface is described. For more detailed information on configuration via the Data platform, see chapter Configuration update.

4.4.1 Connecting the device to the PC

To configure the device with a PC, you must connect it with the PC. For this please use the TFX service tool from the Starter Kit as CAN - PC gateway.

NOTICE

Risk of property damage

Pay attention that the USB plug is correctly aligned to the USB port on the computer before being plugged in and that it is plugged in without using excessive force. Incorrect alignment during connection or the use of excessive force could cause damage to the USB port.

1. Connect the TFX Support Tool to a PC using the cable USB connection cable, USB-A to USB-B, 2 m.
2. Place a CAN bus termination on the D-Sub connector of the TFX Support Tool.
3. Use the cable Start cable for main plug connector with the power supply unit from the starter kit to connect the TFX to the power grid.
4. Use the cable Start cable for main plug connector and the power supply unit from the starter kit to connect the TFX to the power grid.

✓ The ON LED lights up in constant green.

Fig 6. Connection of the TFX to a PC using the TFX SERVICE TOOL

4.4.2 Definition of communication settings

Before you can start using the device, you must define the communication settings.

INFORMATION

Install the USB driver pack (contained within the installer package) before you connect the device to a PC using a USB port. See chapter Installing software.

NOTICE

Risk of property damage

Pay attention that the USB plug is correctly aligned to the USB port on the computer before being plugged in and that it is plugged in without using excessive force. Incorrect alignment during connection or the use of excessive force could cause damage to the USB port.

1. Connect the device to a PC. See chapter Connecting the device to the PC
2. Start the EATON Configurator software.
3. Click on Options > Communication settings in the menu.
✓ The window Communication settings opens.

4. In the Communication gateway area, go to the gateway Device list and select the device TFX Service Tool.
5. In the Communication Gateway area, check the Gateway box.

6. In the USB area, go to the Virtual COM-Port list and select the assigned port of the of the TFX Support Tool (e.g. COM5).

7. In the CAN Baud Rate list, select the baud rate 250 KBIT/S.

8. Click on the Online-Check button to check the connection.

If the connection is successful, the device information is shown in the ID and Version Control area in the ID String and HW SW version fields.

9. Click on the OK button to save the settings.

You have completed the communication settings.

4.4.3 Node scan
Perform a node scan to check the connection.

5. Select the device you want to configure.

6. Click on the Close button.

The Node-ID and the designation of the selected device are shown in the toolbar.

4.4.4 Customizing the demo configuration file

**NOTICE**

Risk of property damage

Pay attention that the USB plug is correctly aligned to the USB port on the computer before being plugged in and that it is plugged in without using excessive force. Incorrect alignment during connection or the use of excessive force could cause damage to the USB port.

1. Connect the device to a PC. See chapter Connecting the device to the PC.

2. Start the EATON Configurator software.

3. Click on the arrow in the toolbar and select Demo Configuration files.

The Open DOD file window opens.

4. Navigate to the right folder for your device and open one of the files with the extension .DOD.
The selected demo configuration file is loaded.

5. Click on File > Save As.. in the menu.
6. Save the file under a different name to avoid overwriting the original file.

**TIP**

You can enter a designation for the configuration in the Device Configuration Version String object of the Device Variables. This text is displayed on the Portal under Status > GSM Info as the DOD version.

- Use an unique designation for every configuration.
- Differentiate between various versions of a configuration by adding a version number. Be sure so save changes after making edits.

7. Adapt the configuration file to your requirements. See also chapter Customizing the demo configuration file.

**INFORMATION**

Save the file with the current configuration in case you need the configuration again later. It is not possible to read out the current configuration from the device.

---

**4.4.5 Loading the configuration to the device**

After you have created your own configuration file, load the configuration to the device.

**NOTICE**

Risk of property damage

Pay attention that the USB plug is correctly aligned to the USB port on the computer before being plugged in and that it is plugged in without using excessive force. Incorrect alignment during connection or the use of excessive force could cause damage to the USB port.

1. Connect the device to a PC. See chapter connecting the device to the PC
2. Start the EATON configurator software.
3. Define the communication settings for the TFX Service tool USB. See chapter definition of communication settings.
4. Perform a node scan and select the CAN node of the corresponding device. See chapter node scan.
5. Choose File > Open from the menu.
6. Open the configuration file you want.
7. Select the Application tab (bottom left corner of the window).
8. Click on the Download All Entries button in the toolbar.
Getting started

✓ The **Download Data to Device** window opens.

9. Click on the **START** button to start the download to the device.
10. Wait until the download is completed.

3. Wait until the **STATUS LED** lights up constantly.

✓ The device is now connected to the PROEMION data platform.

Log into the Portal at portal.proemion.com and check whether the device is connected to the Data platform.

If your device does not appear in the machine overview, you must activate the device. See chapter Activation of the device.

4.6 **Mounting the device**

Below you will find instructions on how to mount the device.

To ensure the housing provides proper fire protection and to achieve the best possible reception of radio signals, make sure you install the device in the correct position.

---

**NOTICE**

Loss of function or configuration.

Disconnection from the power supply during the update process can lead to a loss of the function or the configuration.

- Do not disconnect the power supply during updating.

✓ Now the configuration has been loaded to the device.

11. Click on the **reset CAN Node** button.

12. If you have changed the CAN baud rate (**Device CAN Baud Rate**) in the configuration, check whether the configuration has been correctly adopted.

13. Change the CAN baud rate. See chapter definition of communication settings.

14. Perform a node scan to check the connection. See Chapter Node scan.

✓ The **ON LED** lights up in constant green.
✓ The **STATUS LED** flashes green, then lights up in constant green.

4.5 **Connecting the device to the Data platform**

Before you start the device for the first time, you must connect it to the Data platform.

1. Connect the power supply unit with the power connector of the start cable for main plug connector cable.

2. Plug the power supply unit into the power source.
✓ The **ON LED** lights up in constant green.
✓ The **STATUS LED** flashes green.

---

**INFORMATION**

The mounting material is included in the TFX Kits (both internal and external antenna).

Optionally, you can use the TFX Mounting Kit (part number 102EC99112A). The mounting set contains the following components:

- 2 socket-head screws, DIN 912 - M5x30
- 4 lock washers, M5, d/d = 5.3/9 mm
- 2 hexagon nuts, DIN 934/ISO 4032 - M5

**FIRE PROTECTION**

The view elements of the two LEDs on the device do not comply with the flammability class required for a fire protection housing.
Fire protection of the housing is only guaranteed in the installation positions shown in figures A, B, C or D. Please note that fire protection is not guaranteed in the installation positions shown in figures I and II.

![Fig 7. Installation positions of TFX](image)

**ANTENNA POSITIONING**

The internal antennas (models TFX Internal Antenna) are installed inside the housing on the top of the device. For the best possible reception of GNSS and mobile radio signals, the device should be mounted in the position shown here.

![Fig 8. Antenna positioning](image)

1. Mobile radio antenna
2. GNSS antenna

---

**NOTICE**

Inadequate radio connection.

The radio connection is influenced by objects or walls.

- Only mount the device in the installation position shown in chapter Mounting the device.
- Choose the mounting location so that as few obstructions as possible can influence the radio connection.

**MOUNTING**

Mount the device directly with 2 socket-head screws (M5) inserted in the mounting holes on the sides and screwed to the mounting surface. For detailed information on the distances between the holes, see chapter technical drawings.

![Fig 9. Direct screw mounting, horizontal](image)

1. Socket-head screw DIN 912 - M5x30
2. Lock washer M5 di/da = 5.3/9mm
3. TFX
4. Screw mounting surface Thickness = 3 mm
5. Hexagon nut DIN 934/ISO 4032 - M5

---

**NOTICE**

The recommended screw tightening torque for mounting is 2.2 Nm.
5.0 Operation

This chapter describes how to use the device and the EATON Configurator software.

5.1 Eaton TFX Configurator

Configure the device with EATON Configurator. See chapter Customizing the demo configuration file.

To alter the configuration of your device, first connect it to the PC. See chapter Connecting the device to the PC.

**INFORMATION**

Before you connect the device to a USB port on your PC, install the USB driver packet from Eaton.com/TFX. See chapter Installing software.

**INFORMATION**

You can find helpful information on the individual objects (device variables) at the Additional Information field for each object.

Always use the latest version of EATON Configurator with the updated information texts.

**TIP**

Download the current software version from our website.

The EATON Configurator software can be found at: Eaton.com/TFX

5.1.1 Creating object dictionary groups and objects

In the tree structure of EATON Configurator, you can create, rename, or delete object dictionary groups or objects.

This chapter explains how to create object dictionary groups and objects.

The following example shows creation of the object Receive CAN Messages PDO. This object is used to receive and log CAN messages.

In order to create the object, you need the Custom CAN Communication object dictionary group and then the Receive CAN Messages (PDOs) object dictionary group. If you do not have these:

1. Start the EATON Configurator software.
2. Choose File > Open from the menu.
3. Open the configuration file you want.
4. Right-click on the top entry in the tree structure to open the context menu.
5. In the context menu, click on New Object Dictionary Group > Receive CAN Messages PDO.

- This creates the object dictionary group Custom CAN Communication.

- This creates the object dictionary group Receive CAN Messages (PDOs).

6. Right-click on the object dictionary group Custom CAN Communication.

7. In the context menu, click on New Object Dictionary Group > Receive CAN Messages (PDOs).

8. Right-click on the object dictionary group Receive CAN Messages (PDOs).

9. In the context menu, click on New Object Dictionary Entry > Receive Message PDO.

- This creates the object dictionary group Custom CAN Communication.

- This creates the object dictionary group Receive CAN Messages (PDOs).
This opens the window **Number Of New Objects and their Version**.

10. In the **Number of New Objects** field, enter how many objects (received messages) you want to create.
11. Click on the **Ok** button.
   ✓ The object **Receive Message PDO** is created.

To rename an entry in the tree structure, click on the corresponding entry to select it. Click on the entry again to rename it.

### 5.2 Logging mode

In logging mode, the device logs CAN messages, GNSS data, and internal variables.

All logged data is saved to an internal, nonvolatile memory and automatically sent to the Data platform when a connection is active.

---

**NOTICE**

The internal nonvolatile memory has a capacity of 16 MB and also stores configuration files. The maximum number of files in the internal memory is 4,000, with a file size of up to 1 KB. When the maximum number of 4,000 files is reached, the oldest file will be overwritten every time a new file is saved.

---

**NOTICE**

After the first initialization, the device is automatically in logging mode. If it is then switched to real-time mode, the device remains in real-time mode after a restart.

---

**NOTICE**

Before you start logging data, check the device status in the machine overview in the Portal.
The device must be in logging mode.

The colored squares in the machine overview indicate the current status:

- Constant blue = device is passive in real-time mode
- Flashing blue = device is connected to a real-time client software
- Grayed out = device is offline
- Constant green = device is in file transfer / logging mode
  - Click on the current status to change it.

#### 5.2.1 Configuring logging mode

1. Start EATON Configurator.
2. Choose **File > Open** from the menu.
3. Open the configuration file you want.
4. In the object dictionary group **Device Variables**, click on the variable **Device Mode (Configured)**.

5. In the **Device Mode (Configured)** field, enter the value 0.
6. Click on the **Save Changes** button to save the change.
   ✓ Logging mode is enabled.

---

**NOTICE**

Configuring the **Device Mode** variable during first startup of the device.

After manual switchover of the connection mode or after an automatic switchover by a real-time client software, the device remains in the mode last activated.

- If required, configure the automatic switchover of the device. See chapter Configuring automatic switchover.

#### 5.2.2 Configuring automatic switchover

The device features an automatic switchover function between the logging and real-time modes. The automatic switchover function is enabled as a standard.

You can enable the automatic switchover function and
determine a period (in minutes). If no real-time signal is received from a real-time client software within this period, the device automatically switches back to logging mode.

1. Right-click on Device Variables > New Object Dictionary Entry > Device Variables.
2. In the newly created object dictionary group Device Variables, add the object Realtime Mode - Switch Back to Logging Mode Time.
3. Enter the required value in the Realtime Mode - Switch back to Logging Mode Time field.
4. Click on the Save Changes button to save the change.
   ✓ The automatic switchover function is enabled.

---

The value 0 disables the automatic switchover function.

A value >0 enables the automatic switchover function and simultaneously defines the period after which the device switches to logging mode.

Values from 1 to 4 are not permitted.

### 5.2.3 Configuring variables for CAN communication

To enable CAN communication and data logging, you must configure the following variables.

**CAN VARIABLES**

The variables required concern the CAN connection and belong to the object dictionary group Device Variables.

<table>
<thead>
<tr>
<th>Variable</th>
<th>Value</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>CANOPEN NMT STARTUP</td>
<td>0</td>
<td>Automatically sets the device to CANopen mode &quot;Operational&quot;.</td>
</tr>
<tr>
<td>CAN 1: DEVICE CANopen node-ID</td>
<td>1...127</td>
<td>The CANopen node address (can be left at standard value).</td>
</tr>
<tr>
<td>CAN 1: device CAN BAUD RATE</td>
<td>min. 50 kbit/s, max. 1 mbit/s (default: 250 kBit/s)</td>
<td>The baud rate at which the CAN bus operates.</td>
</tr>
</tbody>
</table>

**LOGGING VARIABLES**

The variables required concern the logfile and belong to the object dictionary group Device Variables > Logging.

<table>
<thead>
<tr>
<th>Variable</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>LOGGING - FILE UPLOAD PERIOD</td>
<td>Period in which the logfile is completed and sent to the Data platform. 0 = data is sent when the size of the logfile reaches 1 kB.</td>
</tr>
<tr>
<td>LOGGING - FILE HEADER TEXT</td>
<td>Information text in the header of each logfile. Can contain for instance version information (max. 32 characters).</td>
</tr>
<tr>
<td>LOGGING - SEND FILE COMMAND</td>
<td>Assign any value to the variable during operation in order to close and transfer the existing logfile.</td>
</tr>
</tbody>
</table>
The logfile is sent to the Data platform when its size reaches 1 kB, irrespective of the period set.

5.2.3.1 Receiving J1939 messages with the PGN 61444

In the following, the example of a J1939 message is used to explain the general procedure for configuring CAN reception messages.

The procedure can also be applied to other CAN messages from other CAN protocols.

For detailed information on creating objects, see chapter Creating object dictionary groups and objects.

**CREATING A PGN 61444**

1. Create the object dictionary group **CUSTOM CAN COMMUNICATION > RECEIVE CAN MESSAGES (PDOs)**. Note that your DOD file may already contain this.

2. In the object dictionary group **RECEIVE CAN MESSAGES (PDOs)**, create a new object dictionary entry **RECEIVE MESSAGES PDO**.

3. Rename the object **RECEIVE MESSAGES PDO** as **pgn 61444**.

**RECEIVE MESSAGE COMMUNICATION PARAMETERS**

4. Right click on the PGN 61444 folder and select the **COMMUNICATION tab**.

5. Set and save the following:

   **Table 16: Communication settings for PGN 61444**

<table>
<thead>
<tr>
<th>Description</th>
<th>Selection</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>VALID ON CAN INTERFACE</td>
<td>Set</td>
<td>Enabling the configuration, defining the CAN interface for reception (if several are available).</td>
</tr>
<tr>
<td>CAN PROTOCOL</td>
<td>None</td>
<td>The receive CAN message is a single message (Layer 2). It is not treated according to a superordinate CAN protocol.</td>
</tr>
</tbody>
</table>

**TIMEOUT AND CONDITIONS**

6. Select the **TIMEOUT AND CONDITIONS tab**.

7. Set and save the following:

   **Table 17: Communications settings in PGN 61444 – Timeout and conditions**

<table>
<thead>
<tr>
<th>Description</th>
<th>Selection</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>ALWAYS ACTIVE</td>
<td>Set</td>
<td>The CAN message is received irrespective of events or conditions.</td>
</tr>
</tbody>
</table>
8. Select the Standard Channel tab.
9. Set and save the following:

Table 18: Communication settings in PGN 61444 – Standard Channel

<table>
<thead>
<tr>
<th>Description</th>
<th>Selection</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Full CAN Message Object</td>
<td>Set</td>
<td>Assigns the receive message to a controller channel.</td>
</tr>
<tr>
<td>ID-Length</td>
<td>29-bit ID</td>
<td>ID length of the CAN message to be received.</td>
</tr>
<tr>
<td>Down-Sample</td>
<td>Set</td>
<td>Receive message max. every 100 ms.</td>
</tr>
<tr>
<td>CoB-ID</td>
<td>Fix</td>
<td>Fixed identifier of the receive message (J1939 PGN 61444).</td>
</tr>
<tr>
<td>Mask</td>
<td>Fix</td>
<td>Determines that bits 8 … 24 of the identifier fixed in CoB-ID must not vary in the identifier of the received message. In the J1939 protocol, the first bits of the identifier define the priority and the last bits of the identifier define the source address. These are ignored when the message is received.</td>
</tr>
</tbody>
</table>

5.2.3.2 Example 1: Log all data bytes every 60 seconds

In this example, all data bytes are simply logged cyclically every 60 seconds. There are no additional conditions, and the data bytes are not checked.

LOGGING - CONDITIONS

Make the following settings for the PGN 61444 object.

1. Select the Logging tab.
2. Select the Conditions tab.
3. Set and save the following:

Table 19: Logging in PGN 61444 - Conditions

<table>
<thead>
<tr>
<th>Description</th>
<th>Selection</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Logging Enabled</td>
<td>Set</td>
<td>Logging enabled</td>
</tr>
<tr>
<td>Log Message on AND</td>
<td>Use a fixed value (60000)</td>
<td>The data is only logged when timeout is reached AND the condition is met.</td>
</tr>
<tr>
<td>Logging Period</td>
<td>Use a fixed value (60000)</td>
<td>Duration of the logging interval in milliseconds.</td>
</tr>
<tr>
<td>Condition / Always true</td>
<td>Set</td>
<td>Logging takes place without prior checking of conditions.</td>
</tr>
</tbody>
</table>

PAYLOAD

4. Select the Payload tab.
5. Set and save the following:

Table 20: Logging in PGN 61444 - Payload

<table>
<thead>
<tr>
<th>Description</th>
<th>Selection</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Log Received CAN Message</td>
<td>Set</td>
<td>Log data of the receive CAN message.</td>
</tr>
<tr>
<td>Bytes to log</td>
<td>All</td>
<td>Log all data bytes.</td>
</tr>
</tbody>
</table>
6. Click on the SAVE button as a final check to make sure all settings were saved.
7. Load the configuration to the device. See chapter Loading the configuration to the device.
   ✓ You have completed the configuration for logging all data bytes of the J1939 PGN 61444 every 60 seconds.

5.2.3.3 Example 2: Log specific data bytes under certain conditions
In this example, specific data bytes are logged according to defined conditions.
Data bytes 2 … 5 and 8 of the CAN messages received are logged when the engine speed (data bytes 4 and 5) changes by ± 500 rpm, or every 10 minutes.
A received CAN message is processed with the following functions:
> Mapping
> Jobs
> Logging

VARIABLES
If you want to log data according to defined conditions, you need certain variables for checking values.
These variables belong to the INTERFACE VARIABLES object dictionary group.

1. Create the object dictionary group INTERFACE VARIABLES.
2. In the INTERFACE VARIABLES object dictionary group, create four new INTERFACE VARIABLE objects.
   ✓ The List of INTERFACE VARIABLES window opens.

Table 21: Interface Variable object

<table>
<thead>
<tr>
<th>Designation</th>
<th>Type</th>
<th>Sign</th>
<th>Size</th>
</tr>
</thead>
<tbody>
<tr>
<td>volatile U8 trigger</td>
<td>volatile</td>
<td>unsigned</td>
<td>8 bits</td>
</tr>
<tr>
<td>volatile S32 engine speed new</td>
<td>volatile</td>
<td>signed</td>
<td>32 bits</td>
</tr>
<tr>
<td>volatile S32 engine speed old</td>
<td>volatile</td>
<td>signed</td>
<td>32 bits</td>
</tr>
<tr>
<td>non-volatile U16 threshold value</td>
<td>non-volatile</td>
<td>unsigned</td>
<td>unsigned</td>
</tr>
</tbody>
</table>

4. Click on the OK button.
   ✓ The INTERFACE VARIABLE object with the selected settings is created.
5. Repeat this procedure for the other three INTERFACE VARIABLE objects.
6. Rename the four INTERFACE VARIABLE objects according to the table.
   ✓ The four INTERFACE VARIABLE objects are displayed.

3. Select the first INTERFACE VARIABLE object according to the following table.
Table 22: Logging in PGN 61444 - Conditions

<table>
<thead>
<tr>
<th>Description</th>
<th>Selection</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Log Message On</td>
<td>OR</td>
<td>The data is logged when timeout is reached OR the condition is met.</td>
</tr>
<tr>
<td>Logging Period</td>
<td>Use a fixed value (600000)</td>
<td>Duration of the logging interval in milliseconds.</td>
</tr>
<tr>
<td>Condition / Always true</td>
<td>not set</td>
<td>The data is logged depending on the result of the check.</td>
</tr>
<tr>
<td>Comparison Value</td>
<td>volatile U8 index</td>
<td>Logging depends on the volatile U8 TRIGGER variable.</td>
</tr>
<tr>
<td>Number of Bits containing data</td>
<td>8</td>
<td>All 8 bits of the variable are compared with COMPARISON VALUE.</td>
</tr>
<tr>
<td>Active if Comparison value</td>
<td>&lt;&gt;0</td>
<td>Data is only logged if the variable volatile U8 TRIGGER is not equal to 0.</td>
</tr>
<tr>
<td>Trigger Condition</td>
<td></td>
<td>Level triggered - This operation will be carried out each time the condition is true.</td>
</tr>
</tbody>
</table>

PAYLOAD

10. Select the PAYLOAD tab.

11. Set and save the following:

Table 23: Logging in PGN 61444 - Payload

<table>
<thead>
<tr>
<th>Description</th>
<th>Selection</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Log received CAN message</td>
<td>Set</td>
<td>Log data of the receive CAN message.</td>
</tr>
<tr>
<td>Bytes to log</td>
<td>2 … 5 and 8</td>
<td>Logging selected data bytes</td>
</tr>
</tbody>
</table>

5.2.3.3.1 Mapping

During mapping, data is copied from the CAN message to variables. You can then process the copied data in the device and perform calculations.

Table 24: Mapping in PGN 61444 – Active Condition

<table>
<thead>
<tr>
<th>Description</th>
<th>Selection</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Always active</td>
<td>Set</td>
<td>Mapping always takes place without conditions.</td>
</tr>
</tbody>
</table>

DATA LINK

4. Select the DATA LINK tab.

5. Make the following changes:

Table 25: Mapping in PGN 61444 – Data link

<table>
<thead>
<tr>
<th>Description</th>
<th>Selection</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Parameter</td>
<td>volatile S32 engine speed new</td>
<td>The data is written to the volatile S32 ENGINE SPEED new variable.</td>
</tr>
<tr>
<td>Data start bit within receive message</td>
<td>24 bits</td>
<td>The data used starts with bit 24 (from byte 4).</td>
</tr>
<tr>
<td>Number of bits containing data</td>
<td>16 bits</td>
<td>The data used has 16 bits (2 bytes).</td>
</tr>
</tbody>
</table>

6. Click on the New button to create the mapping entry.

✓ The mapping entry is adopted in the table.
✓ The data is copied into the internal variable on reception of a CAN message.
5.2.3.4 Jobs

Every time a CAN message is received, jobs are performed after mapping and before logging.

In the Jobs tab, configure the calculation operations you need for your job.

For the example configuration, you need two jobs with the function Calculate Parameter Value Function. With this function, you perform calculation operations and overwrite interface variables with calculated values.

**JOB 1**

With the first job, you check whether the current speed is above or below the threshold value. If one of these two cases applies, the volatile U8 Trigger variable should be set to the value 1. This triggers logging of the CAN message.

1. Select the Jobs tab.
2. In the Current Function of selected Job list, select the function Calculate Parameter Value Function.
3. In the Result list, select the trigger volatile U8 Trigger.
4. Using the buttons in the Mathematics and Logic area, enter the calculation operations (A < (B – C)) or (D > (E + F)).
5. Click on button A.

---

### INFORMATION

If you click on a placeholder (e.g. A), this opens the window Input Operand Information or open a new operation.

You can find the allocation of the variables for this example in the table below.

6. Click on the variable in the list that you want to allocate the placeholder to.
7. Click on the new button when you have entered the calculation operations completely.

---

Allocate the following variables to the placeholders:

#### Table 26: Variables – Job 1

<table>
<thead>
<tr>
<th>Variable</th>
<th>Type</th>
<th>Name/value</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>S32</td>
<td>volatile S32 engine speed new</td>
</tr>
<tr>
<td>B</td>
<td>S32</td>
<td>volatile S32 engine speed old</td>
</tr>
</tbody>
</table>

---

The buttons for entering the calculation operations have the following functions:

<table>
<thead>
<tr>
<th>Buttons</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>C</td>
<td>C = clear: deletes the entire calculation operation</td>
</tr>
<tr>
<td>CE</td>
<td>CE = clear entry: only deletes the last symbol entered</td>
</tr>
</tbody>
</table>

Add variables to the calculation operation.
Click on the button to open a window. Assign fixed values, interface variables, or device variables to the variables. After you have defined a variable, the display on the button jumps to the next variable.

You can find the allocation of the variables for this example in the table below.

- **A**
- **< -**
- **x /**

Basic calculation types (addition, subtraction, multiplication, division)

and = logical AND link
If all linked operands are true or not equal to zero, the result is operation 1. otherwise, the result is operation 0.
or = logical OR link
If one of the linked operands is true or not equal to zero, the result is operation 1. otherwise, the result is operation 0.
If both linked variables are full-number values (integers), the link is made by bits.

Comparison signs (equal to, smaller than, greater than, not equal to, smaller or equal to, and larger or equal to)
The result is 1 when the comparison is true.
The result is 0 when the comparison is not true.

The selected variables are listed under List of Operands, including their values and types.

---

### NOTICE

The calculation formulas are evaluated from left to right. Mathematical priority rules are not observed.

Define the priority calculations in the formula using brackets.

**JOB 2**

In the second job, you replace the value of the variable volatile S32 Engine Speed old with the value of the variable volatile S32 Engine Speed new as soon as the variable volatile U8 Trigger has the value 1.

This updates the speed from which the deviation should be detected.

8. Select the Jobs tab.
9. In the Current Function of selected Job list, select the function Calculate Parameter Value Function.
10. In the Result list, select the trigger volatile S32 Engine Speed old.
11. Using the buttons in the Mathematics and Logic area, enter the calculation operations ((A <> B) * C) + ((D = E) * F).
12. Click on button A.
INFO

If you click on a placeholder (e.g. A), this opens the window input operand information or open a new operation.

You can find the allocation of the variables for this example in the table below.

13. Click on the variable in the list that you want to allocate the placeholder to.

Allocate the following variables to the placeholders:

Table 27: Variables – Job 2
<table>
<thead>
<tr>
<th>Variable</th>
<th>Type</th>
<th>Name/value</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>U8</td>
<td>volatile U8 trigger</td>
</tr>
<tr>
<td>B</td>
<td>fix</td>
<td>00000000</td>
</tr>
<tr>
<td>C</td>
<td>S32</td>
<td>volatile S32 engine speed new</td>
</tr>
<tr>
<td>D</td>
<td>U8</td>
<td>volatile U8 trigger</td>
</tr>
<tr>
<td>E</td>
<td>fix</td>
<td>00000000</td>
</tr>
<tr>
<td>F</td>
<td>S32</td>
<td>volatile S32 engine speed old</td>
</tr>
</tbody>
</table>

14. Click on the New button when you have entered the calculation operations completely.

15. Click on File > Save in the menu.

16. Load the configuration to the device. See chapter Loading the configuration to the device.

✓ You have completed the configuration for logging specific data bytes.

5.2.4 Logging GNSS position data

The GNSS position data contains information on longitude and latitude, altitude, direction, and speed as well as time and date. Data is only logged when valid position data is received.

1. Click on the GPS functionality folder.
2. Set and save the following:

Table 28: GPS functionality
<table>
<thead>
<tr>
<th>Variable</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>ONCE PER FILE</td>
<td>Each logfile contains position data at least once.</td>
</tr>
<tr>
<td>ENABLED</td>
<td>Enables/ disables the position data logging.</td>
</tr>
<tr>
<td>AND / OR</td>
<td>AND: Position data is logged if both conditions (time and distance) are met. OR: Position data is logged if one of the conditions (time or distance) is met.</td>
</tr>
<tr>
<td>LOGGING PERIOD (S)</td>
<td>Time period during which the position data should be logged.</td>
</tr>
<tr>
<td>LOGGING DISTANCE (METERS)</td>
<td>Distance between the last position logged and the current position (linear distance).</td>
</tr>
</tbody>
</table>

NOTICE

Oversampling due to too-frequent logging of GPS position data will cause high data consumption or high number of write cycles on the internal memory.

At the following settings, the position data is logged every 100 ms:

Logging period = 0
Logging distance = 0

These settings generate a high data consumption. If there is no mobile radio connection, the position data is written to the device’s internal memory instead. This considerably reduces the service life of the internal memory.

• Under Variable Logging period, enter a value >= 2 s because the device only receives new GPS data every 2 s.
• Under Variable Logging distance, enter a value above the GPS accuracy.

5.2.5 Configuring the logging of internal variables

You can log various internal variables. Internal variables can be both device variables and interface variables.

To log internal variables, you need an object Action - Function - Operation in the object dictionary group Operation Manager. With the object Action = Function = Operation, up to 8 internal variables can be logged in one process as a virtual CAN message.
1. Start the EATON Configurator software.
2. Choose **File > Open** from the menu.
3. Open the configuration file you want.
4. Create an **Operation Manager** object dictionary group.
5. Create an object **Action - Function - Operation** 1 in the **Operation Manager** object dictionary group.
6. Select the **Basic** tab.
7. Enter a value in milliseconds in the field **This operation will be checked every**. This value determines the intervals at which the variables are logged.
8. Check the **Always active** box. Logging takes place irrespective of conditions. Alternatively, you can define conditions for logging.
9. Click on the **Save** button.
10. Select the **JOBS** tab.
11. In the **Overview** field, click on the **Add** button.
   ✓ The **Create new Job** window opens.
12. Select the job type **Logging**.
13. Click on the **OK** button.
   ✓ The job is added to the **Overview** list.
14. In the **CanId** field, enter the ID (hex) for the virtual CAN message. The ID must not be used by other CAN messages.
15. In the **Add new row** field, select the variable type and the variable.
16. In the **Job parameter** field, click on the **Add** button.
   ✓ The selected variable is added to the **Job parameter** list.
17. Add further variables as required.
18. Click on **File > Save** in the menu.
   ✓ You have completed the configuration for logging internal variables.

### 5.2.6 Evaluating logged data on the data platform

**Writing a Parsing Configuration File (PDC) and Assigning It to a Machine**

In order to be able to evaluate the logged messages and display the signals on the data platform, you must create an additional configuration file (PDC file) and assign it to the device on the data platform.

To find out how to create a PDC file, see the **"PDC Documentation"**.
**DOWNLOADING AND DISPLAYING OR CONVERTING FILES**

You can download data from the data platform and use PROEMION Dashboard to display it or PROEMION Converter to convert it.

PROEMION Dashboard can directly read the saved logfiles (.clf).

With PROEMION Converter, you can convert the data into a comma-separated text file (.csv) or provide the position data for use in Google Earth or Google Maps (.kml).

You can find a description of the logfiles (.clf) in the “clf.pdf” file on the PROEMION Tools CD (path: CD_PROEMION_Tools\Devices\Proemion\clf.pdf). The PROEMION Tools CD also contains sample files and a Windows DLL for converting CLF and CNT files (path: CD_PROEMION_Tools\RMtools\Developer\CLF DLL Demo Projects\RMtools CLF DLL Delphi Demo.zip). You can use this data to write your own converter or import functions.

To find out how to download data from the data platform, see the documentation “PROEMION Web Services API”.

To find out how to configure the Dashboard application to the logged data, see the documentation “EN_Software-Dokumentation RMTools Dashboard”.

---

**5.3 Real-time mode**

In real-time mode, CAN messages are transmitted bidirectionally.

CAN messages and GNSS data can be transmitted in close to real-time.

Use EATON Configurator for the configuration. The basics are described in Chapter Configuring the device.

**NOTICE**

Before you start a real-time session, check the device status in the machine overview in the Portal. The device must be in real-time mode.

The colored squares in the machine overview indicate the current status:

- Constant blue = device is passive in real-time mode
- Flashing blue = device is connected to a real-time client software
- Grayed out = device is offline
- Constant green = device is in file transfer / logging mode

Click on the current status to change it.

**5.3.1 Configuring real-time mode**

1. Start the EATON Configurator software.
2. Choose File > Open from the menu.
3. Open the configuration file you want.
4. In the object dictionary group DEVICE VARIABLES, click on the variable DEVICE MODE (CONFIGURED).
5. In the DEVICE MODE (CONFIGURED) field, enter the value 2.
6. Click the Save changes button to save the configuration.

**NOTICE**

Configuring the DEVICE-MODE variable during first startup of the device.

After manual switchover of the connection mode or after an automatic switchover by a real-time client software, the device remains in the mode last activated.

- If required, configure the automatic switchover of the device. See chapter Configuring automatic switchover.

**5.3.2 Creating a real-time connection and evaluating CAN messages**

For a real-time connection, you must log in to the Portal. There you can download an installation-free version of PROEMION Dashboard in order to evaluate your CAN messages.

To find out how to download the software from the Portal, see the documentation “proemion_portal_dokumentation_EN”.

To find out how to configure the Dashboard application to the logged data, see the documentation “EN_Software-Dokumentation RMTools Dashboard”.

**5.3.3 Setting a reception filter**

You can filter CAN messages for transmission to the Data platform. Set filters using PROEMION Dashboard.

For more information on using PROEMION Dashboard, see the documentation “EN_Software-Dokumentation RMTools Dashboard”.

✓ You have configured the real-time mode.
5.4 File transfer

You can use the device to transfer files between the Data platform and the machine’s CANopen network.

5.4.1 File transfer

**TRANSFERRING A FILE TO THE Data platform**

A simple transfer of files up to 128 kByte via the CAN bus to the Data platform is implemented in the device. The files are saved in the device in an internal nonvolatile memory and automatically transferred to the Data platform when a server link is established.

The following steps are required for the transfer:

1. An external device transfers a file by CANopen SDO protocol to the object 0x5421, 0x03 of the CANlink mobile:
   
   Device variables > File Transfer Transmit - File Data - Cached Mode

2. An external device transfers the file name by CANopen SDO protocol to the object 0x5420, 0x03 of the TFX as a string in the format 8.3:
   
   Device variables > File Transfer Transmit - Filename - Cached Mode

3. An external device writes the value 1 to the object 0x5422, 0x03 of the CANlink mobile. This triggers automatic file transfer to the Data platform:
   
   Device variables > File Transfer Transmit - Command - Cached Mode

You can find out the current available free memory space using the object 0x5423, 0x04 (Device variables > File Transfer Transmit - Get Free Space - Cached Mode). As long as memory space is available, several files can be logged in the device. The files are then automatically transmitted to the Data platform in the order in which they were written to the device.

For detailed information on creating objects, see chapter Creating object dictionary groups and objects.

**READING A FILE TRANSFERRED BY PROEMION**

PROEMION can transfer files in segments of 1024 bytes each via the device. The files transferred by the Data platform are saved to a CANopen control unit in the device in an internal, volatile memory. They can be read off from the device by the CANopen network.

To be able to read off files transferred to the Data platform, you need to take the following steps:

1. Check that the object 0x5402 Sub-Index 0 has the value 01. This value indicates that PROEMION has transferred a file to the device.
   
   File Transfer Receive - Indication

2. If the object has the value 01, you can read the file name from the object 0x5400 Sub-Index 0.
   
   File Transfer Receive - Filename

3. Read off the file from the object 0x5401 Sub-Index 0.
   
   File Transfer Receive - File

4. When the file has been read off, write the value 0 in the object 0x5402 Sub-Index 0.
   
   File Transfer Receive - Indication

   ✓ The device is then ready to receive a new file from the Data platform.

For detailed information on creating objects, see chapter Creating object dictionary groups and objects.

5.4.2 File transfer restrictions

Restrictions apply to file transfer.

The following conditions must be met:

> The file names must have 8 characters and the file extension must have 3 characters (8.3 format).

> Characters permitted for the file name and file extension are “A” … “Z”, “a” … “z” and “0” … “9”.

If these conditions are not met, the device and/or the Data platform will reject the file. This blocks transmission in both directions. To cancel the block, you must delete the faulty file from the Data platform or from the file transfer.

5.5 Encrypted data transfer

The device supports encrypted data transfer to the Data platform according to the TLS standard (Transport Layer Security).

Encrypted data transfer is already enabled when the device is delivered.

The variables required belong to the DEVICE VARIABLES object dictionary group.

### Table 29: Encrypted data transfer

<table>
<thead>
<tr>
<th>Variable</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable encrypted data transfer</td>
<td>0 = disable encrypted data transfer</td>
</tr>
<tr>
<td></td>
<td>1 = enable encrypted data transfer</td>
</tr>
<tr>
<td>Remote Server Port</td>
<td>61200 = port for encrypted data transfer</td>
</tr>
<tr>
<td></td>
<td>60200 = port for unencrypted data transfer</td>
</tr>
</tbody>
</table>

**NOTICE**

Encrypted data transfer is banned in some countries.

Please observe local regulations on encrypted data transfer.

**INFORMATION**

After a device reset to factory settings, encrypted data transfer is enabled as standard.

5.6 Important device variables

This chapter gives you information on important device variables that control the device functions.
5.6.1 Positioning

The device features a GNSS receiver. The GNSS receiver can process signals from the following satellites:

- GPS
- GLONASS
- BEIDOU

Set the combination of the satellite systems in the variable `Positioning > Mode (GNSS)`. The `Positioning > Mode (GNSS)` variable belongs to the `Device Variables > Positioning` object dictionary group.

**Table 30: Positioning – Mode (GNSS)**

<table>
<thead>
<tr>
<th>Variable</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Positioning &gt; Mode (GNSS)</td>
<td></td>
</tr>
<tr>
<td>0 = GPS</td>
<td></td>
</tr>
<tr>
<td>1 = GPS + GLONASS</td>
<td></td>
</tr>
<tr>
<td>2 = GPS + BEIDOU</td>
<td></td>
</tr>
<tr>
<td>3 = GLONASS + BEIDOU</td>
<td></td>
</tr>
</tbody>
</table>

You can read off values from the following variables of the `Device Variables > Positioning` object dictionary group.

**Table 31: Device variables – positioning**

<table>
<thead>
<tr>
<th>Variable</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Positioning - Antenna</td>
<td>Status of the antenna</td>
</tr>
<tr>
<td>Status</td>
<td></td>
</tr>
<tr>
<td>Positioning - Positioning</td>
<td>Status of the position system. Indicates whether valid position data is available</td>
</tr>
<tr>
<td>Data Valid</td>
<td></td>
</tr>
<tr>
<td>Positioning - Active</td>
<td>Number of satellites used</td>
</tr>
<tr>
<td>Satellites</td>
<td></td>
</tr>
<tr>
<td>Positioning - Longitude</td>
<td>Longitude</td>
</tr>
<tr>
<td>Positioning - Latitude</td>
<td>Latitude</td>
</tr>
<tr>
<td>Positioning - Altitude</td>
<td>Altitude of the antenna above sea level</td>
</tr>
<tr>
<td>Positioning - Speed over</td>
<td>Speed over ground</td>
</tr>
<tr>
<td>Ground</td>
<td></td>
</tr>
<tr>
<td>Positioning - GPS</td>
<td>GPS-based measurement of kilometers travelled</td>
</tr>
<tr>
<td>Odometer</td>
<td></td>
</tr>
<tr>
<td>Positioning - Heading</td>
<td>Direction in relation to north</td>
</tr>
</tbody>
</table>

5.6.2 Input/output functions and sensors

The device features input and output functions (3 analog inputs, 1 digital output).

You can measure voltages between 0 V and 15 V with the analog inputs.

**Table 32: Device variables – I/O, sensors, diagnosis**

<table>
<thead>
<tr>
<th>Variable</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operation time total</td>
<td>Device operation time in seconds.</td>
</tr>
<tr>
<td>Device time (Unix format)</td>
<td></td>
</tr>
<tr>
<td>Io - Digital output</td>
<td></td>
</tr>
<tr>
<td>Io - Digital output status</td>
<td></td>
</tr>
<tr>
<td>Io - Terminal 30 voltage</td>
<td>Voltage on terminal 30 connector.</td>
</tr>
<tr>
<td>Io - Terminal 15 voltage</td>
<td>Voltage on terminal 15 connector.</td>
</tr>
<tr>
<td>Io - Terminal 15 (ignition)</td>
<td>0 = input state low (&lt; 2.3 V)</td>
</tr>
<tr>
<td></td>
<td>1 = input state high (&gt; 6 V)</td>
</tr>
<tr>
<td>Io - Device temperature</td>
<td>Device temperature in °C</td>
</tr>
<tr>
<td>Analog input 1</td>
<td>Voltage on Analog Input 1 in volts.</td>
</tr>
<tr>
<td>Analog input 2</td>
<td>Voltage on Analog Input 2 in volts.</td>
</tr>
<tr>
<td>Analog input 3</td>
<td>Voltage on Analog Input 3 in volts.</td>
</tr>
<tr>
<td>Acceleration – X-Axis</td>
<td>Acceleration on the X-axis (in g).</td>
</tr>
<tr>
<td>Acceleration – Z-Axis</td>
<td>Acceleration on the Z-axis (in g).</td>
</tr>
<tr>
<td>Gyroscope - X-Axis</td>
<td>Rate of rotation on the X-axis (in °/s).</td>
</tr>
<tr>
<td>Gyroscope - Y-Axis</td>
<td>Rate of rotation on the Y-axis (in °/s).</td>
</tr>
<tr>
<td>Gyroscope - Z-Axis</td>
<td>Rate of rotation on the Z-axis (in °/s).</td>
</tr>
</tbody>
</table>

The variables Digital output, Digital output status, Analog Input 1, Analog Input 2, and Analog Input 3 are available for the input/output functions.

To enable and configure the input/output functions, you must create additional options.

1. Create the object dictionary group `Io Module Configuration`.
2. Right-click on the object dictionary group `Io Module Configuration`.
3. In the context menu, click on `New Object Dictionary Entry > Channel Setup`.

✔ You have created the objects Analog Input – Channel 1, Analog Input – Channel 2, Analog Input – Channel 3, Analog Input (reserved) – Channel 4, Analog Input (reserved) – Channel 5, And Digital Output – Channel 6.
OUTPUT FUNCTION

Make the settings for the input function under IO Module Configuration > Digital Output – Channel 6.

1. Select the object Digital Output – Channel 6.
2. In the Channel Configuration list, select the configuration ON – OFF Digital Output.
3. Save the changes.

The following variables are available:

<table>
<thead>
<tr>
<th>Table 33: Output functions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Variable</td>
</tr>
<tr>
<td>Channel Configuration</td>
</tr>
<tr>
<td>Behavior on Device Software Status Change</td>
</tr>
</tbody>
</table>

5.6.3 Operation time counter

The operation time counter runs as soon as the device is in standard mode (not sleep mode).

For detailed information on creating objects, see chapter Creating object dictionary groups and objects.

5.6.4 Power management

The device supports the following power modes:

- Standard mode
- Sleep mode (energy saving mode)

You can enable sleep mode as follows.

- > Enabling sleep mode after a set time period:
  Power Management – CAN Sleep Time
- > Monitoring terminal 15. As soon as the device registers LOW on terminal 15, a delay time is enabled. If timeout is reached before the device detects HIGH on terminal 15, the device goes into sleep mode:
  Power Management – Shutdown Delay Time

If the device detects HIGH on terminal 15 or a CAN message while in sleep mode, it switches to standard mode (wake-up).

NOTICE

The device can only be woken from sleep mode into standard mode by CAN1 messages. CAN2 messages are not available with the current product offering.

You can configure additional flags that switch the device to standard mode.

- > Wake-up after a defined time:
  Power Management – Cyclic Wake-Up Time
- > Wake-up due to vibration. You can set the intensity of the vibration:
  Power Management – Acceleration Sensor Wake-Up Force

For detailed information on creating objects, see chapter Creating object dictionary groups and objects.

5.6.5 Geofence

GEOFENCE MODE

The device features a geofence monitoring function. This allows you to monitor whether the device is located inside or outside a pre-defined fence and when the device crosses the fence.

There are three ways to define the fence:

- > Define center and radius of a circle. The center of the circle is defined as a fixed point.
- > Define center and radius of a circle. The current position on enabling the function is used as the center of the circle.
- > Two opposite points are defined for a rectangle.

The variables belong to the object dictionary group Device Variables > Internal Geofence.
Table 34: Geofence definition

<table>
<thead>
<tr>
<th>Variable</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>geofence_mode</td>
<td>0 = Geofence disabled</td>
</tr>
<tr>
<td></td>
<td>1 = Geofence enabled, circle center and radius</td>
</tr>
<tr>
<td></td>
<td>2 = Geofence enabled, circle center, current</td>
</tr>
<tr>
<td></td>
<td>position, and defined radius</td>
</tr>
<tr>
<td></td>
<td>3 = Geofence enabled</td>
</tr>
</tbody>
</table>

Table 35: Geofence status

<table>
<thead>
<tr>
<th>Variable</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>geofence_status</td>
<td>00 = device is outside the fence</td>
</tr>
<tr>
<td></td>
<td>01 = device is inside the fence</td>
</tr>
<tr>
<td></td>
<td>FF = status unknown (e.g. because no position</td>
</tr>
<tr>
<td></td>
<td>data is available)</td>
</tr>
</tbody>
</table>

Geofence status

With the geofence status, you can trigger an event internally. The geofence status is updated every 2 seconds. Every time the geofence status changes, the time is written to a variable. The variables belong to the object dictionary group Device Variables.

5.7 Configuring and reading off variables using the Data platform

You can send special files to the device via the Data platform to configure or read off variables.

In the following, the files and their structure are described.

> Comma (,)
> Value to be written to the variable. All number values (signed / unsigned-integer variables 8 … 32 bits, float 32 bits). The format for floating-point values is “123.45”. You can use decimal or hexadecimal formats.

NOTICE

Do not use commas (,) or semicolons (;) when transferring texts.

> Semicolon (;)
> Comment
> End of line <CR><LF>

Several lines can be written in one file. The lines can have comments. A comment is preceded by a semicolon (;).

Example:

: 0x5353, 0x00, 0; Set File Transfer mode

NOTICE

Function restriction due to faulty OBW file.

It is necessary to check the OBW file.

- Use a local device with CAN access to test the OBW file before transmitting it to a remote device.

OBR FILE

OBR files (*.obr) are used to read out a value from a variable. The device transmits the answer as an OBC file.

The file has the following structure:

> The line starts with a colon (:).
> Object index (e.g. 0x3333)
> Comma (,)
> Sub-Index (e.g. 0x38)
> Semicolon (;)
> Comment
> End of line <CR><LF>

Several lines can be written in one file. The lines can have comments. A comment is preceded by a semicolon (;).

Example:

: 0x3333, 0x38; Read last error state

OBC FILE

The OBC file (*.obc) is transferred by the device as a response to the instruction of an OBR file. The file name is identical to the file name in the OBR file.
5.8 Configuration update

Use EATON Configurator to load a configuration update to the device.

The configuration update can be loaded to the device via the CAN interface or the Data platform. The device identifies and automatically loads the new configuration.

For more detailed information on creating a configuration, see chapter Customizing the demo configuration file.

5.8.1 Data platform

Authorization to perform a configuration update must be registered on the Data platform. Generally, users with administrator rights have this authorization.

INFORMATION

If you do not have authorization to perform a configuration update, contact the service support. See chapter Service and support.

1. Start the EATON Configurator software.
2. Open the corresponding configuration file (.DOD).
3. Click on TARGET DEVICE > OBJECT DICTIONARY > DOWNLOAD > REMOTE DOWNLOAD - ALL ENTRIES or click on the arrow in the toolbar next to the symbol Download all entries.
4. In the window REMOTE CONFIGURATION DOWNLOAD TO TARGET(S), click on the SELECT DEVICES button.
5. Enter your PROEMION user name and password in the SELECT DEVICES window.
6. Click on the LOGIN button.
7. Select the device. The device does not have to be online.
8. Click on the OK button.

NOTICE

Loss of connection due to incorrect parameters.

The online connection may be lost due to incorrect provider parameters. In most cases, it is not necessary to update the security variables, so this should be avoided.

- Before each update of the security variables, check the provider parameters.
9. In the window REMOTE CONFIGURATION DOWNLOAD TO TARGET(S), click on the START button.

✓ The following warning appears.

You are warned against downloading untested configuration files.
10. Click on the YES button.
- The configuration update download starts automatically as soon as the device is online. The download can take several minutes.
- The device recognizes the configuration file and saves it to its internal memory.
- The device LEDs light up in a certain sequence.

**INFORMATION**

For more information on the LED status indications, see chapter Indicator elements (LED).

11. In the **STATUS > GSM Info area** of the portal, check the DoD version and the DoD activation time.

12. In the **Service > Device > Download F ile area** of the portal, check the protocol (update log) for the corresponding machine.

The protocol contains important information regarding the update procedure.

Example of protocol content after a successful update:

> <BEGIN>: 1534329309
> <actSW>: Fw 6.1.0.0 Release
> <actBL>: BI 9.1
> <actDOD>: PROEMION
> File Size: 1132
> Received configuration file
> CONFIGURATION DOWNLOAD COMPLETE
> <newSW>: Fw 6.1.0.0 Release
> <newBL>: BI 9.1
> <newDOD>: CANlink mobile 3337 Demo V1
> <END>: 1534329798

Example of protocol content after a failed update (e.g. due to an incompatible model):

> <BEGIN>: 1534329785
> <actSW>: Fw 6.1.0.0 Release
> <actBL>: BI 9.1

5.8.2 CAN

You can perform a configuration update using the CAN interface.

To be able to load the configuration file to the device, the device must be connected via a CAN-USB port to a PC on which the configuration file is saved.

**NOTICE**

Risk of property damage

Pay attention that the USB plug is correctly aligned to the USB port on the computer before being plugged in and that it is plugged in without using excessive force. Incorrect alignment during connection or the use of excessive force could cause damage to the USB port.

1. Connect the device to a PC. See chapter Connecting the device to the PC
2. Load the configuration to the device. See chapter Loading the configuration to the device.

**5.9 Firmware update**

You can load a firmware update to the device by remote maintenance via the Data platform, via the CAN interface, or via the micro-USB interface (type A).

**NOTICE**

Perform a node scan in EATON Configurator to read out the currently installed firmware version. See chapter Node scan.

Download the firmware from our website: Eaton.com/TFX

5.9.1 Data platform

To be able to upload the firmware update (*.FwBin) to the device remotely via the Data platform, PROEMION Firmware Programmer must be installed on a PC and the firmware update file must be stored.
The authorization to perform the remote firmware update must be given on the Data platform. Generally, users with administrator rights have this authorization.

---

**INFORMATION**

If you do not have authorization to perform a remote firmware update, contact the support service. See chapter Service and support.

1. Start the PROEMION Firmware Programmer software.
2. In the menu, click on **File > Open** and navigate to the storage path for the firmware update (*.FwBin).
3. Select the firmware update (*.FwBin) and click on the **Open** button.
4. In the **Communication Path** field, select the **Connection via Internet (N Devices)** interface from the list.
5. Click on the **Select Devices** button.

   ![Select Devices Window](image)

   ✓ The window **Select Devices** opens.

6. If the list is empty, click on the **Settings** button.
   ✓ The window **Communication Settings** opens.
7. In the **Communication Gateway** field, go to the **Gateway Device list** and select the device **Canlink Mobile**.
8. In the **System Access** field, enter your administrator login credentials for the data platform.
9. Click on the **OK** button to save the settings.
10. Select the device in the **Select Devices** window.
11. Click on the **OK** button.

   ✓ The following warning appears. It points out that the device type and the firmware version will not be verified.
12. Click on the **Yes** button.
13. Click on the **Start Firmware Download** button.
38

INFORMATION

For more information on the LED status indications, see chapter Indicator elements (LED).

The device is restarted.

After the restart, the device uses the updated firmware version.

14. In the SERVICE > DEVICE > DOWNLOAD FILES area of the portal, check the protocol (update log) for the corresponding machine.

The protocol contains important information on the update procedure.

Example of protocol content after a successful update:

> <BEGIN>: 1532699807
> <actSW>: Fw 6.0.41.181 Release
> <actBL>: Bl 9.2
> <actDOD>: FOTA Test V4
> File Size: 435908
> Received firmware file
> Received firmware file correct
> <newSW>: Fw 6.1.0.0 Release
> <newBL>: Bl 9.1
> <newDOD>: CANlink mobile 3337 Demo V1
> <END>: 1532700197

Example of protocol content after a failed update:

> <BEGIN>: 1534330801
> <actSW>: Fw 6.1.0.0 Release
> <actBL>: Bl 9.1
> <actDOD>: CANlink mobile 3337 Demo V1
> File Size: 424836
> Received firmware file
> Update aborted: error file access
> <newSW>: Fw 6.1.0.0 Release
> <newBL>: Bl 9.1
> <newDOD>: CANlink mobile 3337 Demo V1
> <END>: 1534331309

See Service and support for additional questions.

5.9.2 CAN

In order to load the firmware update (*.FWBIN) to the device via the CAN interface, the device must be connected to a PC via a CAN-USB connection. PROEMION Firmware Programmer must be installed on the PC and the firmware update must be stored.

1. Connect the device to a PC. See chapter Connecting the device to the PC
2. Start the PROEMION Firmware Programmer software.
3. In the menu, click on FILE > OPEN CTRL+O and navigate to the storage path for the firmware update (*.FWBIN).
4. Select the firmware update (*.FWBIN) and click on the Open button.

5. Click in the menu on OPTIONS > SETTINGS > COMMUNICATION SETTINGS.

The COMMUNICATION SETTINGS window opens.

6. In the COMMUNICATION GATEWAY area, go to the GATEWAY DEVICE list and select the device TFX SUPPORT TOOL.
7. In the USB field, go to the VIRTUAL COM - PORT list and select the port you require.
8. Click on the ONLINE-CHECK button.
If there is a connection to the TFX Support Tool, the device name and software version will be shown in the corresponding fields.

9. Click on the OK button to save the settings.

10. In the list in the **Communication Path** field, select the interface **Connection via CAN**.
11. Click on the **Search for Targets** button.
✓ The device's node ID is adopted.

**TIP**
If you use a CANviewUSB as a gateway, check the **FAST PROGRAM MODE** box. This increases the speed of the update process.

12. Click on the **Start Firmware Download** button.

13. Wait until the update is finished.

---

**NOTICE**
Device defect due to power failure.

Destroyed file system on the device. Repair by PROEMION necessary.

- Do not disconnect the device from the power supply until the process has been completed.
✓ During the firmware update, the LEDs light up green in the same sequence.
✓ In the field **FIRMWARE DOWNLOAD LOG**, the message **FIRMWARE DOWNLOADED SUCCESSFULLY** appears when the firmware update is complete.
✓ The device restarts automatically.
✓ After the restart, the device uses the updated firmware version.

You can find a tutorial on how to install the firmware to the device in the download area of our website. See also chapter Service and support.

5.9.3 **Micro-USB-A**

In order to load the firmware update (*.FWBIN) to the device via the micro-USB port, the device must be connected to a PC with a USB connection using a USB A to micro-USB-A cable. Additionally, the PROEMION Firmware Programmer must be installed on your PC. If you do not have a USB A to micro-USB-A cable, perform the firmware update either remotely or by CAN.

If you use the micro-USB-A cable the device automatically starts in bootloader mode.

**NOTICE**
Risk of property damage

Pay attention that the micro-USB plug is correctly aligned to the micro-USB port of the TFX before being plugged in and that it is plugged in without using excessive force. Incorrect alignment during connection or the use of excessive force could cause damage to the micro-USB port.

1. Connect the device to a PC with the USB cable, USB A-Micro USB A, 1.8 - 2 m.
2. Connect the device to the power supply grid with the CLM3 start cable, 6 open, 2 dsub, 1 pw, 2 m and the power supply unit from the starter kit.

---

Fig 10. Connecting the TFX to a PC
NOTICE

If it is connected with a USB cable, USB A-Micro USB A, 1.8 - 2 m cable, the device automatically starts in bootloader mode. The LEDs do not light up.

In the USB-Controller field in the Device Manager, the device is shown as “STM Device in DFU Mode”.

3. Start the PROEMION Firmware Programmer software.
4. In the menu, click on File > Open Ctrl+O and navigate to the storage path for the firmware update (*.FwBin).
5. Select the firmware update (*.FwBin) and click on the Open button.

6. In the list in the Communication Path field, select the interface Connection via USB.
7. In the list in the Device field, select RM Device.
8. Click on the Start Firmware Download button.
9. Wait until the update is finished.

NOTICE

Device defect due to power failure.

Destroyed file system on the device. Repair by PROEMION necessary.

- Do not disconnect the device from the power supply until the process has been completed.
- During the firmware update, the LEDs light up green in the same sequence.
- In the field Firmware Download Log, the message Firmware downloaded successfully appears when the firmware update is complete.

10. Disconnect the device from the PC.
11. Disconnect using the main plug connector.

NOTICE

Switching the reset button on the main plug connector is only necessary for models with an integrated battery.

- The device is restarted.
- After the restart, the device uses the updated firmware version.

You can find a tutorial on how to install the firmware to the device in the download area of our website. See also chapter Service and support.

5.10 Over-the-air programming (OTAP)
5.10.1 OTAP introduction

TFX Over-the-air programming (OTAP) software is designed for remotely downloading a new boot application file to an Eaton HFX hydraulic series (HFX) Programmable Logic Controller (PLC). By following the standardized OTAP process, users can update multiple machine HFX PLCs without physically connecting to the controller, which saves time and money.

Refer to the TFX – Over-the-air Programming USER MANUAL for more information regarding OTAP.

5.10.2 OTAP – general process

In general, the OTAP process starts with a user uploading a boot application file to the cloud using a web-based portal provided by Proemion. Then, the Eaton TFX telematics device (TFX) uses a Global System for Mobile Communications (GSM) module to wirelessly communicate with the portal and download the boot application file. Next, the OTAP software verifies HFX controller parameters and safe state status, and the boot application file is internally processed by the TFX. Then, the application file is sent to the HFX controller through a CAN bus using a CAN calibration protocol (CCP). Finally, the TFX downloads the boot application to the HFX controller, and the HFX controller validates the download to conclude the OTAP process. Figure 11 provides a summary of the OTAP process.

Refer to the TFX – Over-the-air Programming USER MANUAL for more information regarding the Eaton-standardized OTAP process.
5.10.3 OTAP Recovery Mode

When a machine cannot verify the safe state or other required OTAP parameters, users can initiate the OTAP Recovery Mode for remote programming. The OTAP Recovery Mode utilizes the TFX’s indicator LEDs and Morse Code to verify the machine’s safe state when there is no proper application on the HFX controller, or if there are missing required parameters, to communicate with the TFX.

Refer to the TFX – Over-the-air Programming USER MANUAL for more information regarding OTAP Recovery Mode.

5.11 Diagnosis via micro-USB port

For diagnosis purposes, you can connect the device directly to a PC via the micro-USB port (type B) and check the device variables.

**NOTICE**
Risk of property damage

Pay attention that the micro-USB plug is correctly aligned to the micro-USB port of the TFX before being plugged in and that it is plugged in without using excessive force. Incorrect alignment during connection or the use of excessive force could cause damage to the micro-USB port.

**NOTICE**
The connection via the micro-USB port is not suitable for carrying out a configuration update. For detailed information on how to carry out a configuration update, see chapter Configuration update.

**INFORMATION**
Before you connect the device to a USB port on your PC, install the USB driver packet from Eaton.com/TFX. See chapter Installing software.

1. Connect the device to a PC with the USB-A to micro-USB-B cable
2. Connect the device to the power supply grid with the cable CLM3 start cable, 6 open, 2 dsb, 1 pw, 2 m and the power supply unit from the starter kit.
   - The ON LED lights up in constant green.

3. Start the EATON Configurator software.
4. Choose File > Open from the menu.
5. Open the configuration installed on the device, or a new demo configuration. If not already available, add the following device variables:

   > Security variables
   - Remote access password
   - Remote server address
   - Remote server port
   - Enable encrypted data transfer
   - Online mode handling
   - E-SIM roaming handling
   - E-SIM operator selection mode
   - E-SIM SIM PIN
   - E-SIM operator selection code
   - E-SIM DNS1
   - E-SIM DNS2
   - E-SIM ISP username
   - E-SIM ISP password
   - E-SIM APN
   - E-SIM SMS service center address

   > Device variables
   - Mobile - engine version
   - Mobile - engine IMEI number
   - Mobile - SIM card ID (ICCID)
   - Device configuration version string
   - Mobile - network state
   - Mobile - modem result
   - Mobile - network mode current
   - Mobile - antenna status
   - Mobile - SIM pin error flag
   - Mobile - CME error number
   - Mobile - state machine current state code
   - Mobile - state machine error code
   - Mobile - CMS error number
   - Mobile - signal quality
   - Mobile - disconnect mode (embedded SIM)
   - Mobile - network mode select
   - Positioning - active satellites
   - Positioning - position data valid

Fig 12. Connecting the TFX to a PC
The diagnosis file selected is loaded.

6. **Click on Options > Communication Settings in the menu.**

The window **Communication Settings** opens.

7. In the **Communication Gateway** field, go to the **Gateway Device list** and select the device **TFX Support Tool**.

8. In the **Communication Gateway** field, check the **Gateway box**.

9. In the **USB** field, go to the **VIRTUAL COM-Port list** and select the port you require (e.g. COM5).

10. Click on the **Online-Check button** to check the connection.

If the connection is successful, the device information of the TFX is shown in the **ID and Version Control area** in the **ID String** and **HW SW Version** fields.

11. In the menu, click on **CAN Filter Settings > Driver optimized settings > Totally open for 11 and 29-bit messages.**

12. Click on the **OK button** to save the settings.

13. Click on **Tools > Node Scan** in the menu. Alternatively, you can click on the button in the toolbar.

The **Communication - Node Scan Information window** opens. The connected CAN devices with their CANopen node-IDs, product codes, and information on hardware and software versions are displayed.

14. Select the device you want to check.

15. Click on the **Close button**.

The node-ID and the designation of the selected device are shown in the toolbar.

16. Check the above-mentioned security variables and device variables and make a note of their entries.

**NOTICE**
To view the current security and device variable entries, select the variable you want and click on the Upload button.

**INFORMATION**
For any further diagnosis, contact the support service. See chapter Service and support.
5.12 Factory reset

Performing a factory reset returns the device to the original settings.

**NOTICE**

Severely restricted functions due to factory reset.

Repair by the supplier is necessary when there is an incomplete configuration on the device.

- Only trained personnel may carry out a factory reset.

**NOTICE**

Complete data loss due to factory reset.

All logged data is deleted from the device memory.

- Back up your data before a factory reset.

5.12.1 Factory reset via OBW file or CAN

The following table provides an overview of the available reset variants which can be triggered by an .obw file or the CAN interface:

<table>
<thead>
<tr>
<th>Table 36: Available reset variants</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Function</strong></td>
</tr>
<tr>
<td>Revert to factory configuration</td>
</tr>
<tr>
<td>Delete all log files</td>
</tr>
<tr>
<td>Revert to firmware defaults remote</td>
</tr>
<tr>
<td>Revert to firmware defaults plus format remote</td>
</tr>
<tr>
<td>Revert to Firmware Defaults Local</td>
</tr>
</tbody>
</table>

**FACTORY RESET USING OBW FILE**

To perform a factory reset using the OBW file, the OBW is transferred to the device via the Data platform for remote maintenance.

The OBW file writes the value 0x64616F6C to the CANopen object index 0x1011 to trigger a specific reset variant.

In the following example, the factory reset using the sub-index 0x01 (revert to factory configuration) is shown:

: 0x1011, 0x01, 0x64616F6C; Revert to Factory Configuration

**INFORMATION**

For more information about the structure of an OBW file, see chapter Configuring and reading off variables using the Data platform.

1. Create a text file with the required value.
2. Save the text file (e.g. ResetAll.obw).

**NOTICE**

Please note that the file name must be precisely eight characters long and that you must change the file extension (*.obw) manually.

4. Log in to the Portal with your administrator access details (user name and password).

**INFORMATION**

If you do not have administrator access, contact your sales or support representative. See chapter Service and support.

5. In the menu, click on Service > Device > Upload Files > Upload File.

6. Select the corresponding machine from the Machine list.
7. Click on the Choose File button and select the OBW file.
8. Click on the Upload button to load the OBW file to the device.
The value of the OBW file is written to the variable in the device.
The device is reset according to the variable.
The ON LED lights up green.
The STATUS LED lights up blue.
The device has completed the reset.

**NOTICE**

Malfunction of the device (reset loop).

If the OBW file remains on the Data platform, the device may no longer function properly.

- After a successful factory reset, delete the OBW file from the Portal using the menu Service > Upload Files > Search, Delete.

**INFORMATION**

For more information on the LED status indications, see chapter Indicator elements (LED).

You can find a tutorial on how to perform a factory reset in the download area of our website. See also chapter Service and support.

**FACTORY RESET VIA THE CAN INTERFACE**

For a factory reset via the CAN interface, you need a CANopen software (e.g. RM CAN-Device Monitor) and a communication gateway (e.g. TFX Support Tool).

The CANopen software writes the value 0x64616F6C to the CANopen object index 0x1011 to trigger a specific reset variant.

In the following example, the factory reset using the sub-index 0x65 (revert to standard configuration) is shown:

**NOTICE**

Risk of property damage

Pay attention that the USB plug is correctly aligned to the USB port on the computer before being plugged in and that it is plugged in without using excessive force. Incorrect alignment during connection or the use of excessive force could cause damage to the USB port.

1. Connect the device to a PC. See chapter Connecting the device to the PC
2. Start the selected CANopen software.
3. Perform the required steps in the CANopen software to write the value 0x64616F6C to the object index, 0x1011 sub-index 0x65.
4. Write the value to the device's object directory.
5. Wait until the device sends the CANopen bootup message to the IDs 0x727 and 0x728.

- The device reverts to the firmware defaults (object 0x1011 0x65).
- The ON LED lights up green.
- The STATUS LED lights up blue.
- The device has adopted the firmware defaults (baud rate 250 kbit/s, node ID 39 etc.).

**INFORMATION**

For more information on the LED status indicators, see chapter Indicator elements (LED).

You can find a tutorial on how to perform a factory reset in the download area of our website. See also chapter Service and support.

5.12.2 Factory reset via the start cable

The factory reset via the start cable corresponds with the function “Revert to Firmware Default Local 0x1011 0x65”.

**NOTICE**

A factory reset via the start cable restores the standard configuration of the current firmware. All logged data and parameters are deleted. The factory configuration is retained.

1. Connect the device to the power supply grid with the cable CLM3 start cable, 6 open, 2 dsub, 1 pw, 2 m and the power supply unit from the starter kit.
2. Slide the switch on the D-Sub connector (CAN1) toward the socket.
The LED on the D-Sub connector (CAN1) lights up red.

3. Wait until both LEDs on the device light up orange.

4. Slide the switch on the D-Sub connector (CAN1) toward the LED.

- The device reverts to the firmware defaults (object 0x1011 0x65).
- The ON LED lights up green.
- The STATUS LED lights up blue.
- The device has adopted the firmware defaults (baud rate 250 kbit/s, node ID 39 etc.).

**NOTICE**

Device defect due to power failure.

Repair by supplier is necessary if there is a destroyed file system on the device.

- Do not disconnect the device from the power supply until the process has been completed.

**INFORMATION**

You can restore the factory configuration of the device using object 0x1011, sub-index 0x01.

**INFORMATION**

For more information on the LED status indicators, see chapter Indicator elements (LED).

See the Service and support section for additional assistance.
6.0 Troubleshooting and maintenance

This chapter contains information on tackling problems and on maintenance.

⚠️ WARNING

Danger to life due to electric shock!

Severe injury or death.

- Never carry out repairs to the device yourself. Contact the support team. The device does not contain any parts that can be repaired or maintained by the user.

NOTICE

Property damage.

Any defective device must be inspected and repaired by a trained PROEMION service technician.

- Do not open the device housing yourself.

6.1 Remedies

Table 37: Problems and potential causes

<table>
<thead>
<tr>
<th>Problem</th>
<th>Possible cause</th>
</tr>
</thead>
<tbody>
<tr>
<td>Device does not function.</td>
<td>Check the power supply via the main plug connector.</td>
</tr>
<tr>
<td>Device does not receive CAN messages.</td>
<td>Check the CAN connection and the configuration of the CAN messages. Check whether the bus terminating resistor is correctly mounted.</td>
</tr>
<tr>
<td>Device does not receive GNSS signals.</td>
<td>Check the antenna connection and cable for damage. Position the antenna or the device so that it directly points to the sky.</td>
</tr>
<tr>
<td>Device does not receive mobile radio signal.</td>
<td>Check the antenna connection and cable for damage. Check the eSIM configuration in the eSIM - Specials object dictionary. Position the antenna or the device so that it directly points to the sky.</td>
</tr>
<tr>
<td>Device does not log data.</td>
<td>Check the CAN baud rate in the configuration. Check in the configuration whether the device is in &quot;Operational&quot; mode. Check the logging configuration.</td>
</tr>
</tbody>
</table>

6.1.1 Support request

If you do not find the solution to your problem in this manual, please contact our support service. See chapter Service and support.

The support team requires the following information in order to help you.

- Read off the following device variables:
  - Mobile - engine IMEI number
  - Mobile - network state

- What is the condition of the STATUS LED?
  - Is the STATUS LED constant green?
  - Does the STATUS LED indicate a fault?

- If the STATUS LED is constant blue, read off the following device variables:
  - Mobile - State Machine Error Code
  - Mobile - CMS Error Number
  - Mobile - CME Error Number
  - Mobile - SIM pin error flag

- Read off the following security variables:
  - Mobile - Signal Quality
  - Remote server address
  - Remote server port
  - Enable encrypted data transfer
  - Online Mode Handling
  - E-SIM roaming handling
  - E-SIM operator selection mode
  - E-SIM SIM PIN
  - E-SIM operator selection code
  - E-SIM DNS1
  - E-SIM DNS2
  - E-SIM ISP username
  - E-SIM ISP password
  - E-SIM APN
  - E-SIM SMS service center address

- Read off the following device variables:
  - Mobile - engine version
  - Mobile - engine IMEI number
  - Mobile - SIM Card ID (ICCID)
  - Device configuration version string
  - Mobile - network state
  - Mobile - modern result
  - Mobile - network mode current
  - Mobile - antenna status
  - Mobile - SIM pin error flag
  - Mobile - CME Error Number
  - Mobile - State Machine current state code
  - Mobile - State Machine Error Code
  - Mobile - CMS Error Number
  - Mobile - Signal Quality
  - Mobile - disconnect mode (embedded SIM)
  - Mobile - network mode select
  - Positioning - Active Satellites
  - Positioning - position data valid
Use the support form to send the information to the support service.

6.1.2 Connection problems to the Data platform

If the device does not connect to the Data platform, check the following:

- Is the configuration correctly loaded to the device? See chapter Loading the configuration to the device.
- Are the device LEDs lighting up correctly? See chapter Indicator elements (LED).
- Are the contract and device settings in the Portal correct?
- Are the mobile radio parameters in EATON Configurator correct?

You can find more information in this chapter.

**Portal**

In the Portal, check whether the contract and device settings are correct.

1. Log in to the Portal.
2. Navigate to the field Administration > Entities > Device > Manage.
3. Enter the device name or IMEI number in the search box.
4. Click on the Details button of the corresponding device.

![Portal Interface](image)

- The detail view of the selected device is shown.
5. In the field Hosting Contract Number, check whether the device has a current contract.
6. Check whether the Permission To Connect To Promeion box is checked.
7. In the Machine list, check whether the device is allocated to the right machine.
8. In the Organization Unit list, check whether the device is allocated to the right organizational unit.

**EATON CONFIGURATOR**

Check in EATON Configurator whether the mobile radio parameters are correct.

The variables belong to the Device Variables and Security Variables object dictionary groups.

1. Start the EATON Configurator software.
2. Choose File > Open from the menu.
3. Open the configuration file you want.
4. In the Mobile object group, check each object setting.

![EATON Configurator Interface](image)

If you do not find the solution to your problem in this manual, please contact our support service. See chapter Service and support.
Packaging and transport

6.2 Maintenance
Regularly check all connectors for a firm connection.
See chapter Service and support.

⚠️ WARNING
Danger to life due to electric shock!
Severe injury or death.

• Never carry out repairs to the device yourself. Contact the support team. The device does not contain any parts that can be repaired or maintained by the user.

NOTICE
Property damage.

Any defective device must be inspected and repaired by a trained supplier service technician.

• Do not open the device housing yourself.

7.0 Packaging and transport
This chapter contains information on packing and transportation.

NOTICE
Property damage.

• Only store and transport the device in a temperature range of -40 °C … +85 °C / -40 °F … +185 °F.

NOTICE
Property damage.

Protection class IP6K7 is only ensured when all connectors except the micro-USB port are correctly fitted with protection caps.

• Close all connectors with protection caps.
8.0 Disposal

This chapter contains information on correct disposal.

**NOTICE**

Observe local regulations for disposal of the device, the accessories, and the packaging material.

8.1 Regulations in the European Union

According to the Directive on Waste Electrical and Electronic Equipment (WEEE), the device must not be disposed of in household waste. Take the device to a collection point for waste electrical and electronic equipment for correct disposal.

9.0 Annex

This chapter contains technical data and certificates.

9.1 Technical drawings

**INFORMATION**

You can receive CAD files on request. Please contact our support service. See chapter Service and support.

---

Fig 13. Dimensions of the TFX
(here: variant with external antenna connectors)

Fig 14. Dimensions of the TFX
(here: variant with external antenna connectors)
9.2 Technical data

This chapter contains information on the technical data of the device.

9.2.1 Mechanical data

Table 38: Mechanical data

<table>
<thead>
<tr>
<th>Dimensions width/height/depth [mm]</th>
<th>86 / 123 / 35</th>
</tr>
</thead>
<tbody>
<tr>
<td>Color</td>
<td>Black</td>
</tr>
<tr>
<td>Protection class</td>
<td>IP6K7</td>
</tr>
<tr>
<td>The protection class is only ensured if all connectors of the device are plugged in or covered with suitable protection caps.</td>
<td></td>
</tr>
<tr>
<td>Temperature range</td>
<td>Standard mode: -40 °C … +80 °C / -40 °F … +176 °F</td>
</tr>
<tr>
<td>Weight</td>
<td>TFX Internal Antenna: 160 g</td>
</tr>
<tr>
<td>TFX External Antenna: 140 g</td>
<td></td>
</tr>
<tr>
<td>Standard housing material</td>
<td>PA 66/6 - FR</td>
</tr>
<tr>
<td>Pressure equalizing membrane</td>
<td>Yes</td>
</tr>
</tbody>
</table>

9.2.2 Electrical data

Table 39: Electrical data

<table>
<thead>
<tr>
<th>Supply voltage range terminal 30 DC</th>
<th>12 / 24 V — ±50 %</th>
</tr>
</thead>
<tbody>
<tr>
<td>Power consumption, standard mode terminal 30 (24 V)</td>
<td>&lt; 250 mA (standard mode)</td>
</tr>
<tr>
<td>Max. &lt; 500 µA (sleep mode)</td>
<td></td>
</tr>
<tr>
<td>Average power consumption</td>
<td>&lt; 6 W</td>
</tr>
<tr>
<td>Controller</td>
<td>Arm cortex M4 168 MHz</td>
</tr>
<tr>
<td>Memory expansion program flash</td>
<td>1 MB</td>
</tr>
<tr>
<td>Memory expansion data flash</td>
<td>16 MB</td>
</tr>
<tr>
<td>Memory expansion FRAM</td>
<td>8 kB</td>
</tr>
<tr>
<td>Memory expansion SRAM</td>
<td>760 kB</td>
</tr>
<tr>
<td>LEDs</td>
<td>2 LEDs, RGB (red/green/blue)</td>
</tr>
<tr>
<td>RTC with back-up capacitor</td>
<td>Back-up time: 48 h at 25 °C</td>
</tr>
<tr>
<td>Synchronisation: GNSS/PROEMION</td>
<td></td>
</tr>
<tr>
<td>Accuracy: ±2 s/day</td>
<td></td>
</tr>
<tr>
<td>CAN (number, ISO)</td>
<td>TFX Internal Antenna: 1 (ISO 11898-2/-5)</td>
</tr>
<tr>
<td>TFX External Antenna: 1 (ISO 11898-2/-5)</td>
<td></td>
</tr>
<tr>
<td>CAN specification</td>
<td>2.0 A/B</td>
</tr>
<tr>
<td>Max. CAN baud rate</td>
<td>1000 kbit/s</td>
</tr>
<tr>
<td>Mobile radio</td>
<td>TFX External Antenna: GSM/UMTS</td>
</tr>
<tr>
<td>Mobile radio transmission rate</td>
<td>Models TFX Internal Antenna, TFX External Antenna:</td>
</tr>
<tr>
<td>2G/GSM/GPRS/Edge</td>
<td></td>
</tr>
<tr>
<td>850/1800/1900 MHz</td>
<td></td>
</tr>
<tr>
<td>3G/UMTS/HSPA 850/900/1900/2100 MHz</td>
<td></td>
</tr>
<tr>
<td>Maximum mobile radio transmission performance</td>
<td>33 dBm with GSM</td>
</tr>
<tr>
<td>33 dBm with GPRS</td>
<td></td>
</tr>
<tr>
<td>27 dBm with Edge</td>
<td></td>
</tr>
<tr>
<td>24 dBm with UMTS</td>
<td></td>
</tr>
<tr>
<td>24 dBm with HSPA</td>
<td></td>
</tr>
<tr>
<td>23 dBm with LTE (EU)</td>
<td></td>
</tr>
<tr>
<td>23 dBm with LTE (NA)</td>
<td></td>
</tr>
<tr>
<td>GPRS upload: 85.6 kbit/s</td>
<td></td>
</tr>
<tr>
<td>GPRS download: 85.6 kbit/s</td>
<td></td>
</tr>
<tr>
<td>Edge upload: 236 kbit/s</td>
<td></td>
</tr>
<tr>
<td>Edge download: 236 kbit/s</td>
<td></td>
</tr>
<tr>
<td>UMTS upload: 384 kbit/s</td>
<td></td>
</tr>
<tr>
<td>UMTS download: 384 kbit/s</td>
<td></td>
</tr>
<tr>
<td>HSPA upload: 5.7 Mbit/s</td>
<td></td>
</tr>
<tr>
<td>HSPA download: 7.2 Mbit/s</td>
<td></td>
</tr>
<tr>
<td>LTE upload: CAT1 5.2 Mbit/s</td>
<td></td>
</tr>
<tr>
<td>LTE download: CAT1 10.3 Mbit/s</td>
<td></td>
</tr>
<tr>
<td>Digital OUT</td>
<td>1 digital output</td>
</tr>
<tr>
<td>Terminal 30 switching 6 Vdc ... 36 Vdc</td>
<td></td>
</tr>
<tr>
<td>max. output current: 500 mA</td>
<td></td>
</tr>
<tr>
<td>max. switch frequency: 10 Hz</td>
<td></td>
</tr>
<tr>
<td>Surge-proof up to 36 Vdc</td>
<td></td>
</tr>
<tr>
<td>Reverse voltage protection up to -36 Vdc</td>
<td></td>
</tr>
<tr>
<td>Digital input</td>
<td>3 analog inputs</td>
</tr>
<tr>
<td>Measurement range: 0 Vdc to 15 Vdc</td>
<td></td>
</tr>
<tr>
<td>Input resistance: 20 kΩ</td>
<td></td>
</tr>
<tr>
<td>Resolution: 12 bit</td>
<td></td>
</tr>
<tr>
<td>Sampling rate: 20 Hz</td>
<td></td>
</tr>
<tr>
<td>Surge-proof up to 53 Vdc</td>
<td></td>
</tr>
<tr>
<td>Reverse voltage protection up to -53 Vdc</td>
<td></td>
</tr>
<tr>
<td>Tolerance: ±1 % of measurement range end value (at 25 °C)</td>
<td></td>
</tr>
<tr>
<td>Analog IN</td>
<td>1 digital input</td>
</tr>
<tr>
<td>Terminal 15</td>
<td>1 digital input</td>
</tr>
<tr>
<td>Measurement range: 0 Vdc to 78 Vdc</td>
<td></td>
</tr>
<tr>
<td>Input resistance: 103 kΩ</td>
<td></td>
</tr>
<tr>
<td>Resolution: 12 bit</td>
<td></td>
</tr>
<tr>
<td>Digital switching threshold: 5.5 Vdc (hysteresis 2.3 Vdc)</td>
<td></td>
</tr>
<tr>
<td>Surge-proof up to 100 Vdc</td>
<td></td>
</tr>
<tr>
<td>Reverse voltage protection up to -100 Vdc</td>
<td></td>
</tr>
<tr>
<td>Tolerance: ±1 % of measurement range end value (at 25 °C)</td>
<td></td>
</tr>
</tbody>
</table>
9.2.4 Protocols

Table 41: Protocols

<table>
<thead>
<tr>
<th>Layer 2</th>
<th>Yes</th>
</tr>
</thead>
<tbody>
<tr>
<td>CANopen</td>
<td>Yes</td>
</tr>
<tr>
<td>J1939, OBDII</td>
<td>Yes</td>
</tr>
</tbody>
</table>
| Customer-specific | On request |}

9.2.5 Status indicators

Table 42: Status indicators

| All model variants | 2 RGB LEDs (ON / STATUS) |
List of tables

Table 1: Available TFX models......................................................................................................................................................2
Table 2: Required hardware components for TFX operation........................................................................................................3
Table 3: Required software for TFX operation...........................................................................................................................3
Table 4: TFX available accessories ..............................................................................................................................................3
Table 5: Listed functions for TFX models.....................................................................................................................................6
Table 6: Main plug connector pin layout .....................................................................................................................................7
Table 7: GNSS antenna port pin information .................................................................................................................................8
Table 8: Mobile radio antenna port pin information ....................................................................................................................8
Table 9: Micro-USB port pin information ....................................................................................................................................8
Table 10: ON LED status indicators and their meaning ...............................................................................................................9
Table 11: STATUS LED indicators, connections, priority, and their meaning .............................................................................9
Table 12: LED operating modes, status indications, and their meaning ....................................................................................10
Table 13: CAN baud rate and corresponding maximum bus length ............................................................................................14
Table 14: Variables concerning the CAN connection .................................................................................................................22
Table 15: Logging variables ............................................................................................................................................................22
Table 16: Communication settings for PGN 61444 ..........................................................................................................................23
Table 17: Communications settings in PGN 61444 – Timeout and conditions ................................................................................23
Table 18: Communication settings in PGN 61444 – Standard Channel .......................................................................................24
Table 19: Logging in PGN 61444 - Conditions ...............................................................................................................................24
Table 20: Logging in PGN 61444 - Payload .....................................................................................................................................24
Table 21: Interface Variable object ..................................................................................................................................................25
Table 22: Logging in PGN 61444 - Conditions ...............................................................................................................................26
Table 23: Logging in PGN 61444 - Payload .....................................................................................................................................26
Table 24: Mapping in PGN 61444 – Active Condition ...................................................................................................................26
Table 25: Mapping in PGN 61444 – Data link ...................................................................................................................................26
Table 26: Variables – Job 1 ...............................................................................................................................................................27
Table 27: Variables – Job 2 ...............................................................................................................................................................28
Table 28: GPS functionality ...............................................................................................................................................................28
Table 29: Encrypted data transfer ....................................................................................................................................................31
Table 30: Positioning – Mode (GNSS) ..........................................................................................................................................32
Table 31: Device variables – positioning ....................................................................................................................................32
Table 32: Device variables – I/O, sensors, diagnosis ..................................................................................................................32
Table 33: Output functions ...............................................................................................................................................................33
Table 34: Geofence definition ...........................................................................................................................................................34
Table 35: Geofence status ...............................................................................................................................................................34
Table 36: Available reset variants ..................................................................................................................................................43
Table 37: Problems and potential causes ...................................................................................................................................46
Table 38: Mechanical data ...............................................................................................................................................................50
Table 39: Electrical data .................................................................................................................................................................50
Table 40: Interfaces ...........................................................................................................................................................................50
Table 41: Protocols ...........................................................................................................................................................................51
List of figures

Fig 1. Device overview TFX ...........................................................................................................................................................1
Fig 2. TFX type label (here: model variant TFX internal antenna) .................................................................................................1
Fig 3. Acceleration sensor TFX .....................................................................................................................................................7
Fig 4. Gyro sensor TFX .................................................................................................................................................................7
Fig 5. Power supply unit with country adapters .......................................................................................................................13
Fig 6. Connection of the TFX to a PC using the TFX SERVICE TOOL ........................................................................................15
Fig 7. Installation positions of TFX ..............................................................................................................................................19
Fig 8. Antenna positioning ..........................................................................................................................................................19
Fig 9. Direct screw mounting, horizontal ...................................................................................................................................39
Fig 10. Connecting the TFX to a PC ............................................................................................................................................39
Fig 11. Summary of the OTAP process .......................................................................................................................................40
Fig 12. Connecting the TFX to a PC ...........................................................................................................................................41
Fig 13. Dimensions of the TFX (here: variant with external antenna connectors) .................................................................49
Fig 14. Dimensions of the TFX (here: variant with external antenna connectors) .................................................................49